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INTRODUCTION

MC Developer’s Workshop is part of a series of task-centered books that focus
on solutions to common programming tasks. The purpose of this book is to
assist developers in quickly implementing common features found in Mi-
crosoft Foundation Class (MFC) applications. It is intended as a solution set
for intermediate developers, not as an introduction to the MFC library.

What’s in This Book

This book consists of a collection of programming tasks that center around
the MFC library. The tasks presented in the collection are problems com-
monly encountered during the development of Microsoft Windows applica-
tions using Microsoft Visual C++ and their solutions. Each task presents the
steps and information needed to implement a particular feature or behavior.

How This Book Is Organized

This book is designed to demonstrate the modularity of the MFC library
through a series of focused programming tasks. The structure of the book is
itself modular; each chapter includes a discussion of the general topic to be
covered (usually an area of program functionality or an area of the MFC li-
brary) and several common tasks that illustrate various details of the topic be-
ing discussed (for instance, documentview architecture, dialog boxes, and
menus and controls). Each chapter (and each task within the chapter) is self-
contained. The only common thread from one task to another is that all tasks
implement a solution to a problem using components of the MFC library.
Having said this, however, I recommend you read Chapter 1 before jumping
into the rest of the book because it introduces the modular approach that
clarifies the relationships among the various components of the MFC library.

Is This Book for You?

This book is intended for people who have had at least one year of experi-
ence developing MFC applications for Windows or who have developed one
or two small applications using MFC. It will also be helpful if you understand

Xi
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the basic concepts of C++ programming, such as class inheritance and over-
riding member functions.

What You Need to Use This Book

To use this book, you will need version 2 or later of the MFC library. The con-
tents of the book are based on the MFC library and not on the development
interface, so you don’t have to have Visual C++ or Microsoft Developer Studio.
However, I recommend using either Visual C++ version 2 or later or Developer
Studio because they are tightly integrated with the MFC library and greatly
simplify programming for Windows.

Overview of Chapters

Chapter 1

In Chapter 1, I demonstrate the functionality of AppWizard and the modular-
ity of the MFC library through a series of five tasks. Each task addresses the
addition of a specific feature (available via AppWizard) to an existing MFC ap-
plication—a good introduction to using the class.

Chapter 2

In Chapter 2, I focus on MFC tasks from an application-wide perspective.

Each of the seven tasks demonstrates a feature that affects the entire applica-

tion, such as customizing the system menu or implementing tooltips for vari-
~ ous types of tools. '

Chapter 3

In Chapter 3, the life cycle of a document-view pair in an MFC application is
discussed in detail. In the discussion, I walk you through the steps to create
the document, frame, and view elements and discuss the various points at
which you can customize the process. The three tasks in the chapter demon-
strate creating multiple views on a single document, creating switchable views,
and customizing the interface for choosing a new document.

Chapter 4

The four tasks of Chapter 4 address the topic of dialog boxes and illustrate
the techniques you can use to implement various features for them. Among

Xii
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the topics discussed are customizing the background of a dialog box, custom-
izing common dialog boxes, and implementing custom DDX functions.

Chapter 5

The five tasks included in Chapter 5 address the use of various Windows con-
trols in your application—for example, modifying the application menu that
is based on the current open child window, moving list box data to and from a
CStringArray object, and implementing tooltips for dialog controls.

Chapter 6 -

The four tasks in this chapter deal with various aspects of using Microsoft Ac-
tiveX controls and implementing OLE in MFC applications. Some of the is-
sues I address include marking a control as safe for scripting and initializing
when used in Microsoft Internet Explorer, implementing a custom OLE inter-
face, and loading an ActiveX control property asynchronously.

vChapter 7

This chapter consists of a group of miscellaneous tasks related to MFC appli-
cations, their components, and their interactions with the system. Some ex-
amples include saving the system state from one program session to the next,
implementing resource-only DLLs, and implementing drag and drop sup-
port for an MDI application.

Chapter 8

Six of the eight tasks presented in this chapter address using DAO database
classes and sample databases to link data sources to Microsoft Access, to open
data sources directly, and to mix static and dynamic binding in an application.
The remaining two tasks address using output parameters with the ODBC
API and using ODBC database classes to open a recordset on a stored procedure.
Nondatabase techniques that are discussed within these tasks include using
Developer Studio components from the Gallery and using ActiveX controls.

| Comments and Questions

If you have comments or questions regarding this book or ideas for other tasks
you would like to see addressed in future editions, contact me at the address
provided below:

http: //mspress.microsoft.com/mspress/products/1066

xiii
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CHAPTER O N E

AppWizard and the MFC Library

AppWizard was developed by the same people who developed the Microsoft
Foundation Class (MFC) library, for which reason it’s the best and most effi-
cient starting place for your MFC development. AppWizard is like the framer
of a new house; it knows its materials (the elements of the MFC library) and
what’s needed to set up the basic structure (in this case, an MFC application).

AppWizard initially uses a series of six dialog boxes to create a blueprint
for your project. The first dialog box helps you set up your application frame-
work (single document interface or multiple document interface), set up sev-
eral basic features whose scope is application-wide (such as OLE abilities and
Data Access Objects), and set up several common features (such as print pre-
view and context-sensitive help). After you have made your choices, AppWizard
shows you the current plan. Unlike designing a house, where you must pay an
architect for every change to the initial plan, you can jump back and forth at
will between pages and change options until you’re satisfied. Once you are
satisfied, you can examine the framework objects (each represented by a class)
and modify basic features (such as derivation from a certain parent class, file-
name, and so forth). AppWizard designs the pad (the underlying architecture)
and the frame (OLE or database) on the basis of your choices.

After you click OK, AppWizard builds the application framework using
. various objects from the MFC library, such as frame windows, documents,
control bars, and views. When it is finished, you have a fully functioning frame-
work application, that is, you can build and execute the project without er-
rors and without crashing. Granted, its functionality is limited, but how many
people build just the frame of their new home and then move in? At this point,
you start adding the floors, windows, doors, and siding.

This chapter is not intended either as a tutorial for using AppWizard or
as a broad overview of the library. I focus on the modularity of the MFC library
and how AppWizard uses it to generate a framework application. We will break
down a project that has been created with AppWizard in a modular fashion in-
stead of breaking it down exclusively by classes or files.
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Background

One of the primary purposes of this discussion, and of the book in general, is
to describe the way components implemented by MFC classes are put togeth-
er, pulled apart, or customized with relative ease by AppWizard or by you. In
the tasks that are included in this chapter, I will demonstrate this modularity
by customizing several common features offered by AppWizard and then
show exactly what AppWizard creates to implement your project’s desired fea-
tures. The discussion covers the following major topics:

B General architecture of a framework application
The general framework components of an MFC application gen-
erated by AppWizard are described, using a model of layering to dis-
cuss each basic type of MFC application: dialog box—based, single
document interface (SDI), and multiple document interface (MDI).

& Application types created by AppWizard
The concept of modularity is used to describe the three types of
basic applications created by AppWizard: dialog box-based, SDI, and
MDI. Each type of application is described and broken into its respec-
tive elements; the classes that AppWizard generated are then used to
implement the elements of the framework.
# Application-wide options provided by AppWizard
This is a brief discussion of how OLE compound document and
database support options affect the basic application framework.

& Customizing application features
This is a brief discussion of the ways an application created with
AppWizard can be customized.

General Architecture of a Framework Application

The typical MFC application consists of three layers (Figure 1-1): primary,
secondary, and tertiary.

The Primary Layer

The primary (or innermost) application layer contains objects that make up
the framework of the application (Figure 1-2 on page 6). In most cases, this
layer is created solely by AppWizard. Using your input, AppWizard creates a
project that contains classes that implement the four base elements of your
application:

B An application element An element that is implemented by a CWin-
App-derived class. The application element is the first thing created
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fertiar

Application] Document

Frame
Window

Figure 1-1.
The three layers of a typical MFC application.

when your application executes. It is responsible for initializing the
application data and creating the remaining application framework
elements.

E A frame window element An element that is commonly implemented
by a CFrameWnd-derived (or CMDIFrameWnd-derived) class. The
frame window element acts as the container for the interface ele-
ments of the application: the windows and the controls of your appli-
cation. The frame window element is the second thing that is created
when your application executes. This element is primarily responsi-
ble for creating the document and view elements of the application -
and managing the control bars of the window object. Sometimes the
frame window element is referred to as the glue of the application be-
cause it creates and links the other application framework elements
together. However, it is also one of the least often modified elements
of an MFC application.
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B Application Document

Frame
Window

Figure 1-2.
The primary layer of a typical MFC application.

# A document element An element that is commonly implemented by

a CDocument-derived class. The document element contains the data
of the application and is half of a document-view pair. It is responsi-
ble for storing and retrieving data from external sources, modifying
application data, and notifying all view objects related to the docu-
ment when changes have occurred. It is one of the most misunder-
stood elements of the MFC application. (For more details on the
document-view pair, see the discussion in Chapter 3, “Document
Templates.”

A view element An element that is implemented by a CView-derived
class. This element implements the graphical side of the document-view
relationship. It is responsible for rendering a graphical representation
of the document element and the state of the document or applica-

tion. Because MFC applications run on the Microsoft Windows oper-

ating system, the “view” is the workhorse of an MFC application and
the most heavily modified element. Like the document element, the
view element is often misunderstood.
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These four elements are the “parents” of the second and third applica-
tion layers. For example, if you want an application with a single document
interface that can display bitmaps, AppWizard generates an application
framework consisting of these four basic elements, on which you later build.

Note that not all applications created with AppWizard have these four
elements of the primary layer. Dialog box-based applications have only an
application element and a dialog box element. The dialog box element takes
the place of the frame window, document, and view elements.

The Secondary Layer

The secondary application layer (Figure 1-3) includes additional application
elements that represent the data or items used by the application. These ele-
ments are the objects with which an element of the primary layer, such as the
document element, interacts closely.

Dialog box (allows user

:4o'chobse.a BMP file] -
qertiary Laye, l— Ao.chovse.a BMP file).

Application | Document

Frame
Window

Control bars
. {toolbay,
statos bar).:

.
-
.....

~ CPaletis class

'A@di‘tiéhaﬂmgcii@g@!ﬁy ‘ ! .
for control bars

Figure 1-3.
The secondary layer of a typical MFC application.
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The elements can be implemented by classes created with ClassWizard
or added from other projects. The secondary layer is usually where the bulk
of the implementation code can be found whether it is added manually or
with ClassWizard. In an application that displays bitmaps, for example, this
layer might consist of an element class of type CBitmap that stores the bitmap
currently being displayed. Another class derived from CPalette might store the
bitmap’s palette. In most cases, this layer is implemented after you have cre-
ated the application framework using AppWizard but before you implement
the tertiary layer. However, at other times the secondary and tertiary layers
are implemented simultaneously.

The Tertiary Layer

The final, or tertiary, application layer (Figure 1-4) provides the final touches
and specific details of the application—that is, the items that are manipulated
by elements of the secondary layer. Because the tertiary layer interacts with the
application to varying degrees, depending on the application, it is not con-
sidered a “true” framework layer.

Frame
Window

-
-
ae="
am=

Figure 1-4.
The tertiary layer of a typical MFC application.
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In an application that displays bitmaps, the tertiary layer might provide
functionality for control bars beyond the functionality provided by AppWizard;
or it might provide a dialog box that shows the statistics of the current bitmap
in graphical form. In some cases, these details can be provided by overriding
a function of an existing parent class or by adding a new data member to
track a common value. In other cases, such as when you add a new dialog box,
this layer might consist of an entire class that is used by the view element to
display bitmap information. Implementation of the tertiary layer is usually
the last thing completed before testing or release. Sometimes the layer is not
completed. After all, you must have something for the next release!

Application Types Created by AppWizard

AppWizard can build three “houses™ dialog box-based, SDI-based, and MDI-
based. Using a modular method of development, you can build on these frame-
works with little modification to the underlying code. To use the house-building
analogy again, not using a modular approach would be like hacking holes in
interior walls and putting in windows for quick access, putting doors on the
second floor because the existing doors just don’t work, or..., well, you get
the idea. If you don’t have a solid understanding of the underlying architec-
ture, you will have problems adding elements without damaging the existing
framework. Keeping the modular method of development in mind, let’s look
at the three possible types of applications AppWizard can build for us.

NOTE: If you choose OLE compound document support or
database support when using AppWizard to create an application,
the primary and secondary layers of your application will be modi-
fied. These changes consist mainly of the addition of elements that
implement either OLE or database support and changes in the deri-
vation of some classes. For more information, see “OLE Options”
on page 14.

Dialog Box—Based Applications

The dialog box—based application is the simplest of the three types of applica-
tions to create because it only takes two classes to implement all four primary
elements. The application element is still the core of the application. How-
ever, the framework, document, and view elements are replaced by a dialog
box element. Because the dialog box class, which implements the dialog box
element, is derived from CWhnd, the dialog box object inherits the functional-
ity of a window object. In addition, the dialog box object takes the place of a
document-view pair by storing both the data and the graphical interface in
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the dialog box class. Therefore, in this element model the application element
is implemented with a CWinApp-derived class and the other three elements
with a CDialog-derived class. You might have to add another class or two for
additional functionality, but most of your work will be contained within the dia-
log box element. Figure 1-5 illustrates the primary layer of the framework cre-
ated by AppWizard for a dialog box—based application.

. User Data

Applicatioﬁ Element
(derived from CWinApp)

p .- UserData e

Frame Window, Document,
and View Element
(derived from CDialog)
Figure 1-5.
The framework of a typical MFC dialog box—based application.

The table on the next page relates each application framework element
to its respective MFC class.

SDI Applications

The SDI application is a more modularized version of the application frame-
work created by AppWizard (Figure 1-6 on page 13). In an SDI application,
the application element handles the initialization of the other primary ele-
ments and interacts with the system. The application uses just one frame window
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Element Class Comments

Application CWinApp-derived The application element initializes
any application data and performs
any actions before the application
becomes visible.

Frame window CDialog-derived The frame window element mani-
pulates and displays data using a
dialog box. Other elements can
be added as members to the dia-
log box class.

Document CDialog-derived Dialog box controls are the main
and also other interface, and they handle the
classes majority of the work. Data mem-

bers can be added to store infor-
mation from the user.

View CDialog-derived Controls are the main interface,
and they handle the majority of
thevwork.

element that contains the document and view elements and that is the glue of
the document-view pair. In an SDI application, the majority of code creates and
manages any control bars of the frame window. Because this is an SDI appli-
cation, all application control bars are managed by the frame window. More
code can be added for initialization purposes. And you can also have the
frame window store application data that directly affects both the document
and the view elements.

However, the real workers in the application are the document and view
elements. In the MFC library, these two elements are implemented by two
closely related classes derived from CDocument and CView. These classes can
access each other with pre-implemented member functions. (For more infor-
mation on the mechanics of documents, views, and document templates, see
the discussion in Chapter 3, “Document Templates.”)

In the SDI element model, the application element is implemented once
again with a CWinApp-derived class. The frame window element is implemented
with a CFrameWnd-derived class, and the document and view elements are
implemented with CDocument-derived and CView-derived classes, respectively.
Figure 1-6 on the following page illustrates the primary and secondary layers of
the framework created by AppWizard for an SDI-based application. The table on
the following page relates each framework element to its respective MFC class.

11
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Document Element
(derived from CDocument)

m_pMainWnd

Application Element
(derived from CWinApp)

User Data o

E %

View Element
(derived from CView)

Figure 1-6.

5

Frame Window (SDI)
(derived from CFrameWnd)

The framework of a typical MFC SDI application.

Comments

Element Class

Application CWinApp-
derived

Frame CFrameWnd-

window derived

- Document CDocument-

derived and
also other
classes

View CView-
derived and
also other
classes

Initializes any application data and per-
forms any actions before the application
becomes visible.

Manages the creation of the application’s
control bars and some message handling.

Contains the application’s data in the
form of data members or pointers to user-
derived classes. Closely tied to the view
element through member functions.

Graphically displays the state of the docu-
ment data and of the application. Closely
tied to the document element through
member functions.
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MDI Applications

The primary layer of an MDI application is exactly the same as the primary
layer of an SDI framework except for the presence of an additional frame
window object. This additional object contains the document-view pairs of
the MDI application. Figure 1-7 illustrates the primary and secondary layers
of the framework created by AppWizard for an MDI application.

Document Element Application Element
(derived from CDocument) (derived from CWinApp)

View Element Frame WII‘ICiOW (MDI)
(derived from CView) (derived from CMDIFrameWnd)

Child Window Element
(derived from CMDIChildWnd)

Figure 1-7.
The framework of a typical MFC MDI application.

13
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In an MDI application, unlike an SDI application, you can have multiple

- child windows open, each of which contains a different view of the same

document or which contain views of different documents. If you look at the
MDI application as an element framework, this ability adds an extra object
between the main application frame window and the view. Instead of the
main frame window having direct access to the view, it must now query for the
active child window of the application and then, with that object, query for
the attached view. Within an MDI application, you can almost think of each
child window as a mini-application.

In the MDI element model, the application element is implemented the
same way as an SDI application except that the main frame window element is
implemented with a CMDIFrameWnd-derived class, which contains additional
code for handling MDI child windows within the application. The additional
frame window object for the MDI application, the child window, is implemented
with a CMDIChildWnd-derived class. Once again, code was added to function
properly in an MDI environment. The document and view elements are im-
plemented with CDocument-derived and CView-derived classes, respectively.

As the name suggests, an MDI application can contain multiple docu-
ments. Each document is part of a document template that contains a frame
window, a document, and a view object. If the application has more than one
document template and the user wants to create a new document, a dialog
box displays the available document types to the user. The table on the next
page relates each application framework element to its respective MFC class.

Application-Wide Options Provided by AppWizard
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When we create an application with AppWizard, there are two steps that affect
the structure of the application framework. The effects include the addition
of classes that provide OLE compound document support and database sup-
port. In addition, the parents of some application framework elements can
change, depending on what options are selected.

OLE Options

By default, AppWizard does not automatically include OLE compound docu-
ment or database support. If you choose to include these (which are found
on the second and third steps of AppWizard), the primary and secondary lay-
ers of the application will change significantly. There are four possible varia-
tions of OLE compound document support: container, mini-server (for SDI
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Element

Class

Comments

Application

CWinApp-derived

Initializes any application data
and performs any actions before
the application becomes visible.

Application’s CMDIFrameWnd- Manages the creation of the ap-

frame window derived plication’s control bars, all MDI
child windows, and some message
handling.

Child window CMDIChildWnd- Used to manage control bars and
derived to handle certain messages. Like

the main frame window, this ele-
ment is the glue of each docu-
ment type.

Document CDocument-derived Contains the application’s data in
and also other the form of data members or
classes pointers to user-derived classes.

Closely tied to the view element
through member functions.

View CView-derived and Graphically displays the state of

also other classes the document data and the appli-
cation. Closely tied to the docu-
ment element through member

functions.

applications only), full-server, and container/server. (For a complete descrip-
tion of these types of support, see online documentation for AppWizard.)

Container support If you choose to include container support, your docu-
ment class is derived from COleDocument. This class includes extra support for
the activation of objects called clients in an OLE document. In addition, a new
element called a client (or client item) is added to the secondary layer. The
client item is implemented using a COleClientItem-derived class and acts as an
intermediary between the OLE item and the client.

Mini-server support (for SDI applications only) If you choose to include
mini-server support, your document class is derived from COleServerDoc in-
stead of CDocument. This class includes server support for interaction with

15
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server items. Visual editing for the items, within the document-view architec-
ture, is also supported. In addition, two new elements are added to the sec-
ondary layer. The first element, implemented with a COleServerltem-derived
class, represents the server items of your application. The second element,
implemented with a COleIlPFrameWnd-derived class, is the frame window of a
server item that has been activated within your application. The following
table relates each element to its respective class.

Element Class Comments

Server COleServerltem- Acts as an intermediary between the
item derived OLE item and the server.

In-place COlelPFrameWnad- Handles the placement of toolbars with-
frame derived in the container’s application window.
window Also handles notifications when the in-

place window is resized.

Full-server support If you choose to include full-server support, the same
derivation changes and element additions are made that are made for a mini-
server. The only difference is in the implementation code.

Container/server support Support for a container/server is basically pro-
vided by a combination of the container and server elements. Once again,
the derivation of your document class is COleServer The new elements are
classes that implement the client item, the server item, and an in-place frame
window. This implementation is specified in the following table.

Element Class Comments .

Client item COleClientltem- Acts as an intermediary between the
derived OLE item and the client.

Server item COleServerltem- Acts as an intermediary between the
derived OLE item and the server.

In-place COleIPFrameWnd- Handles the placement of toolbars

frame derived within the container’s application

window window. Also handles notifications

when the in-place window is resized.
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Database Support Options

The database support options are simpler to implement than other options
because they require fewer modifications to the primary layer. The first op-
tion simply adds the header files to your project. The second and third op-
tions change the derivation of the view element from CView to CRecordView.
As I mentioned earlier in the chapter, support is added to the view class for
easily displaying database records. A new element, derived from CRecordSet, is
added to the second layer of the MFC application. This class implements the
database query function of your application and stores information about
database queries performed in your application. (See Chapter 8 for informa-
tion about MFC and databases.)

Customizing Application Features

Besides using AppWizard to set up the core elements of your application, you
can choose from a variety of application-wide features to customize your
framework application. These features range from fundamental application-
wide elements to the small user-interface details that always seem to be left
until the end of the project. AppWizard, for the most part, plays it safe by us-
ing a default customization that includes most of the cooler user interface
features (such as control bars, print preview, and so on) and stays away from
the more fundamental features (such as OLE compound document support).

To demonstrate the modularity of an application created with AppWizard,
I have included five tasks in this chapter that show how to retrofit several of
the most common AppWizard features to an existing application.

# Adding a dockable toolbar and a status bar to an existing MFC
application

# Adding an MRU list to an existing MFC application

# Adding print preview to an existing MFC application

# Adding MAPI and Windows Sockets support to an existing MFC
application

# Converting an existing MFC SDI application to MDI

For a complete discussion of the features of AppWizard, see the
AppWizard article family in Programming with MFC Encyclopedia and “Creating
Applications Using AppWizard” in VC++ User Guide.

17



PART I: WORKSHOP

Adding a Docking Toolbar and a
Status Bar to an Existing MFC Application

The purpose of this task is to add a docking toolbar and a status bar to the
main frame window of an existing MFC application. A docking toolbar con-
tains buttons for common tasks, such as opening and saving files, editing, and
printing. It can be docked on any side of the application’s main frame win-
dow or can be dismissed, as the user chooses. The status bar, positioned at the
bottom of the application’s main frame window, displays descriptive text for
toolbar buttons and idle-time messages. A status bar requires only a parent
class and code that creates and initializes the status bar. An MFC docking
toolbar, on the other hand, requires several elements:

B A bitmap that represents the toolbar buttons

# Code that maps each toolbar button to a command ID

B A CWnd-derived class in the application that will function as the par-
ent of the toolbar

B Code that creates and initializes the toolbar

The task of adding a docking toolbar and a status bar to an application
consists of three steps:

1. Importing a bitmap resource to an application
2. Adding member variables and message map entries

3. Adding initialization and implementation code for the control bars

The requirement for this task is a bitmap resource for the toolbar. (A
default toolbar bitmap resource can be found in the DEFAULT.RC file on the
companion CD-ROM, located in the \Projects\Default directory.)

After you have completed the task, the application will have a docking
toolbar and a status bar exactly as if you had chosen the toolbar and status bar
option in AppWizard.

Step 1: Importing a Bitmap Resource into an Application

18

For simplicity’s sake, only the bitmap resources will be added in this step. The
status bar code will be added later. There are two methods for creating a bitmap
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resource for an application: importing a resource from another project and
inserting a new toolbar with the Resource editor. Because we will be adding
an entire toolbar—a toolbar bitmap and command mappings for each but-
ton—it is easier to import an existing bitmap resource. To prevent conflicts as
much as possible, we will use the toolbar generated by AppWizard (Figure 1-8).

r-‘f, Untitled - DefaultSDlApp FEEE

Figure 1-8.
Default toolbar generated by AppWizard.

The default toolbar generated by AppWizard has eight buttons, each
mapped to a task. To import an existing toolbar into an application, follow
these steps: ‘

1. Load your project into Microsoft Visual C++ and select the Resource-
View pane.

2. Open the resource file (with the extension of RC) containing the
toolbar you will import. A resource file containing the default toolbar
can be found in the DEFAULT.RC file, located in the \PROJECTS\DE-
FAULT directory on the companion CD-ROM.

3. Expand the toolbar node by double-clicking the Toolbar folder icon.

19
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4. Drag the IDR_MAINFRAME object to the ResourceView pane, and
drop it onto the resource folder object.

5. Save the resource file.

Your project should now have a toolbar folder that contains
IDR_MAINFRAME. Your resource script has been modified to include a bit-
map resource (the toolbar bitmap) and a toolbar. In addition, the bitmap has
been copied into your application’s \RES subdirectory.

TIP: Ifyour application does not support Print Preview, be sure
you remove the Print Preview button.

Step 2: Adding Member Variables and Message Map Entries
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Now you have to modify portions of the application code. The application’s
main frame window normally is the parent of any control bars, so you will
now have to add member variables to the application’s main frame window
class for both the toolbar and the status bar. Specifically, you need to modify
the CMainFrame class (derived from CFrameWnd or CMDIFrameWnd) by add-
ing two protected member variables to the header file of class CMainFrame
(MAINFRAME.H) as shown below. These two variables contain the toolbar
and the status bar objects after the application creates them.

protected: // Control bar embedded members
CStatusBar m_wndStatusBar;
CToolBar m_wndToolBar;

You also need a place to create and initialize the control bars before the
application is used. Use the handler for the WM_CREATE message to do this.
At this point, just add this handler to your CMainFrame class, either manually or

using ClassWizard. The new code (in bold) should look similar to the follow-
ing examples.

& In the header file:

afx_msg int OnCreate(LPCREATESTRUCT 1pCreateStruct);
// NOTE - the ClassWizard will add and remove member
// functions here.

# In the implementation file:

ON_WM_CREATE()
//}}AFX_MSG_MAP
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Now modify the CMainFrame implementation file to add the status bar.
Add the following lines of code immediately after the end of the message
map declaration:

static UINT indicators[] =

{
ID_SEPARATOR, // Status line indicator
ID_INDICATOR_CAPS,
ID_INDICATOR_NUM,
ID_INDICATOR_SCRL,
1

This code creates a static array, named indicators, that stores a common
set of flags. These flags indicate the state of certain keys (such as Scroll Lock)
in the status bar. (For more information on status bar indicators, see Techni-
cal Note 22 in the Visual C++ online documentation.)

Step 3: Adding Initialization and
Implementation Code for the Control Bars

Now create and initialize the control bars in the WM_CREATE handler. To
add control bar code, follow this procedure:

1. Add the code below to the WM_CREATE handler after the call to the
base class OnCreate function:

if (Im_wndToolBar.Create(this) ||
Im_wndToo1Bar.LoadToo1Bar(IDR_MAINFRAME))

{
TRACE@("Failed to create toolbar\n");
return -1; // Fail to create

}

if (!m_wndStatusBar.Create(this) ||
Im_wndStatusBar.SetIndicators(indicators,
sizeof(indicators)/sizeof(UINT)))

TRACE@Q("Failed to create status bar\n");
return -1; // Fail to create
}

2. To display tooltips and make the toolbar resizeable, include the fol-
lowing code lines after the code that creates the control bars in the
OnCreate function of CMainFrame:

m_wndTool1Bar.SetBarStyle(m_wndToolBar.GetBarStyle() |
CBRS_TOOLTIPS | CBRS_FLYBY | CBRS_SIZE_DYNAMIC);

21
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3.

To make the toolbar dockable, add the following code lines after the
code that creates the control bars in the OnCreate function of CMain-
Frame:

m_wndTool1Bar.EnableDocking(CBRS_ALIGN_ANY);
EnableDocking(CBRS_ALIGN_ANY);
DockControlBar(&m_wndToo1Bar);

Your application’s main frame window now has a docking toolbar and a
status bar.

Additional Information

A common feature of control bars is the ability to determine whether to dis-
play them or not. This ability to display or hide the control bars is accom-
plished by making use of two standard command IDs. To add the ability for
users to toggle control bars on and off, follow these steps:

22

1.

5.

Switch to your project’s ResourceView pane, and open the main
menu resource, commonly named IDR_MAINFRAME.

Add a top-level menu named View. (If you already have this menu,
skip to the next step.)

Add a command named Toolbar to the View menu. This command
should have the resource ID ID_VIEW_.TOOLBAR.

Add a command, named Status Bar, to the View menu. This com-
mand should have the resource ID ID_VIEW_STATUS_BAR.

Save your project’s resource file.

You can also use CFrameWnd::ShowControlBar to display or hide your ap-
plication’s control bars. This function can be called from any menu com-
mand handler or can be called directly as the result of some action—for
example, the appearance of a certain type of window. (For more information
on using CFrameWnd.::ShowControlBar, see the CTRLBARS MFC sample that is
located in the Visual C++ section of Books Online.)

The following articles in the Microsoft Knowledge Base contain infor-
mation related to toolbars and status bars:

#® SAMPLE: Adding Control Bars to Dialog Boxes in MFC: Q141751
B Setting First Pane of CStatusBar: Q110505 ,
# Displaying the Current Time in a CStatusBar Pane: Q99198
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Adding an MRU List to
an Existing MFC Application

The purpose of this task is to enable an existing MFC application to display a
most recently used (MRU) list in the File menu. An MRU list is a common fea-
ture of most Windows applications, as shown in the example in Figure 1-9.
The list, commonly found on the File menu, allows the user to select from the
last n files accessed. It is enabled by a call to LoadStdProfileSettings and modifi-
cation of the application’s menu resource.

Tl

Figure 1-9.
The MRU list of an application created with AppWizard.

The following procedure modifies a menu resource by adding an entry
for the MRU list under the File menu. To add a menu entry for an MRU list,
follow these steps:

1. Use Visual C++ to open the RC file of the target project.

2. Open the main menu resource of the project, which is commonly
named IDR_MAINFRAME.

3. Add a new command named Recent File with the ID
ID_FILE_MRU_FILE1 to the File menu, and check the grayed check
box in the Properties dialog box for the new menu item. This ID is

23
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predefined by the MFC library, and the command will be disabled un-
til the MRU list has one or more entries. If you want, you can add a
separator menu item to differentiate the MRU list from the preced-
ing menu entries. '

Once this command has been added, a call to CWinApp::Load-
StdProfileSettings can be made in the application’s InitInstance func-
tion. The call can be made in the beginning of the function as
follows:

BOOL CProjNaApp::InitInstance()
{

// Load standard INI file options (including MRU)
LoadStdProfileSettings();

This function loads the default settings for an application of this type
and maintains an MRU list for the application. You can disable the
MRU list by passing 0 to LoadStdProfileSettings.

When you enable the MRU list for your application, you will notice that
the file list never exceeds 4 entries. This is the default number of entries speci-
fied by the MFC library. However, the framework can handle a list of up to 16
entries. To increase the number of items in the MRU list, pass the number to
the application’s call to LoadStdProfileSettings. For example, for an MRU list
that contains ten filenames, make the following call in your application’s Init-
Instance:

LoadStdProfileSettings(10); // Load standard INI file options
// (including MRU)

To learn more about this command handler and other handlers, see
Technical Note 22 in the Visual C++ online documentation.

Adding Print Preview to
an Existing MFC Application

24

The purpose of this task is to add print preview to an existing MFC applica-
tion. When you have completed the task, your application will have a Print
Preview menu item and the user will be able to preview the application’s cur-
rent document. The task has two steps:

1. Adding new menu resources to an application

2. Adding handlers for the new print commands
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The requirement for this task is a main frame window menu with addi-
tional submenus.

Step 1: Adding New Menu Resources to an Application

In this first step, add the Print and Print Preview menu items to the applica-
tion’s File menu. This allows easy access to print preview and printing as well
as supporting the code that handles the Print and Print Preview requests.
The end result is similar to the menu pictured below in Figure 1-10:

Figure 1-10.
The top-level File menu of a standard MFC application.

In most cases, when an application requires printing resources (such as
buttons or views), it gets them from a resource file named AFXPRINT.RC,
which contains common MFC printing resources, such as dialog boxes and
resource strings. For your application to have access to these resources, you
must include this resource file in your project’s RC file. This can be done ei-
ther by adding the RC file manually or by adding the resource file using the
Resource Includes dialog box. If you want to add resource files using the Re-
source Includes dialog box, follow this procedure:

1. Load your project’s workspace.

2. Choose Resource Includes from the View menu.

25
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3. In the Compile-Time Directives list box, scroll down until the follow-
ing line appears:

#include afxres.rc // Standard Components

4. Enter the code line below immediately after the line in the preceding
step.

#include afxprint.rc // printing/print preview resources

5. Click OK to dismiss the dialog box.

You will get a second dialog box that warns you of dire consequences if
you didn’t enter the code correctly. This is just one of many instances in
which Microsoft Developer Studio is making sure you know what you are do-
ing. Because you are the daring type, go ahead and click OK. Now add the
Print, Print Preview, and Print Setup commands to the File menu of your ap-
plication. I assume that you are familiar with adding menu items, so I will give
you just the properties for each item. Be sure you insert a separator item just
before the Print menu item.

Print Menu Properties

ID Caption Prompt
ID_FILE_PRINT &Print..\t Print the active docu-
- Ctrl+P ment\nPrint

ID_FILE_PRINT_PREVIEW Print Pre&view Display full pages\n
Print Preview

ID_FILE_PRINT_SETUP P&rint Setup... Change the printer and
printing options\n
Print Setup

The last items you need to add to the RC file are two strings that are
used as explanatory text on the status bar. Because you are familiar with add-
ing string resources to an application, I will provide you only with the values
you need in the table on the next page. The position of the values is not impor-
tant in the string table.

Once you have made modifications, save the resource file.

Step 2: Adding Handlers for the New Print Commands

Now that you’ve added the graphic front end for printing to your applica-
tion, you have to add command handlers for the new commands. You will

26
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String Table Properties

ID Caption

ID_FILE_PAGE_SETUP Change the printing options\nPage Setup
AFX_IDS_PREVIEW_CLOSE Close print preview mode\nCancel Preview

add two standard sets of handlers, which will match the handlers created by
AppWizard if Print Preview is chosen. I divided the handlers into two sets be-
cause one set must be added by hand, although you can use ClassWizard to
add the other. (For more information on these standard command handlers,
see Technical Note 22 in the Visual C++ online documentation.)

The first set of handlers, consisting of four print commands, just calls
the default command handler of the base class. Of course, because you are
working with C++ classes, you can remove the existing handlers and add your
own, using ClassWizard, if the default behavior isn’t good enough. To add the
first set of command handlers, follow these steps:

1. Open the implementation file of the application class.

2. Add the following line of code after the handlers for ID_FILE_NEW
and ID_FILE_OPEN:

// Standard print setup command
ON_COMMAND(ID_FILE_PRINT_SETUP, CWinApp::0OnFilePrintSetup)

This function invokes the standard Print Setup dialog box.

3. Add the remaining handlers—ID_FILE_PRINT, ID_FILE_PRINT
_DIRECT, and ID_FILE_PRINT_PREVIEW—to the view class mes-
sage map. In the implementation file of the view class, add the follow-
ing lines of code (shown in bold) after the end of the ClassWizard
portion of the message map:

//}YAFX_MSG_MAP

// Standard printing commands

ON_COMMAND(ID_FILE_PRINT, CView::0OnFilePrint)

N_COMMAND(ID_FILE_PRINT_DIRECT, CView::0OnFilePrint)

ON_COMMAND(ID_FILE_PRINT_PREVIEW, CView::0nFilePrintPreview)
END_MESSAGE_MAP()

Respectively, these handlers print the current document using the
Print dialog box, print the current document bypassing the Print dia-
log box, and enter Print Preview mode for the current document.
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Because the code for handling the next set of commands is implemented
in the application’s view class, you can use ClassWizard. Follow these steps:

1. Open ClassWizard for your project. From the Message Maps page of
ClassWizard, choose the view class.

2. From the listing of messages on the right, add the OnBeginPrinting,
OnEndPrinting, and OnPreparePrinting functions.

3. Click OK to exit ClassWizard.

You should end up with three declarations in your view class’s header
file similar to the ones below:

protected:

virtual BOOL OnPreparePrinting(CPrintInfox pInfo);

virtual void OnBeginPrinting(CDCx pDC, CPrintInfo* pInfo);
virtual void OnEndPrinting(CDC* pDC, CPrintInfox* pInfo);
//}}YAFX_VIRTUAL

And you should have three function bodies in your view class’s implementa-
tion file as shown below:

// CPPrevView printing
BOOL CPPrevView::0nPreparePrinting(CPrintInfo* pInfo)

{ // default preparation
return DoPreparePrinting(pInfo);
aoid CPPrevView: :0nBeginPrinting(CDC* pDC, CPrintInfoxpInfo)
{ // TODO: add extra initialization before printing
ioid CPPrevView::0nEndPrinting(CDCx pDC, CPrintInfox pInfo
{ // TODO: add cleanup after printing
}

After adding these print handlers, add specific code to each function to
fully implement them.

Adding MAPI and Windows Sockets
Support to an Existing MFC Application

The purpose of this task is to enable an existing MFC application to support
the Microsoft Messaging application programming interface (MAPI) and
Windows Sockets. MAPI provides your application with the ability to create,
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send, and otherwise manipulate mail messages. It is commonly seen in MFC
applications as a Send Mail option on the File menu. MFC support for this
API is not complete, but the basic functionality is available through the CDocu-
ment class. Even though the MFC support is incomplete, all MAPI functions
can be called directly from a MAPI-enabled application. (For more informa-
tion about MAPI support and for answers to more MAPI-specific questions,
see the articles “MAPI” and “MAPI Support in MFC” in the Visual C++ online
documentation.)

Windows Sockets enables an MFC application to support a socket (an
end point of communication across a network). Sockets are used to send and
receive data. MFC uses two classes to implement support for sockets: CAsync-
Socket (implemented with minimal wrapping) and CSocket (implemented with
a “heavier” wrapping for ease of use). (For more information on Windows
Sockets, see the articles “Windows Sockets in MFC: Overview” and “Windows
Sockets: Background” in the Visual C++ online documentation.)

After you complete this task, your application will have the same sup-
port for MAPI and Windows Sockets that it would have had if you had used
AppWizard to add it when you created the application. This task has two steps:

1. Adding the Send Mail command and string resources

2. Adding support code

Step 1: Adding a New Menu Item and String Resources

First add a command that allows the user to send mail messages, and also add
some strings for informational prompts and error messages to the File menu.
I assume that you are familiar with adding menu items, so I will just provide
you with the properties and let you do the rest. Be sure you insert a separator
item right after the Send menu item.

Send Menu Item Property

D Caption Prompt
ID_FILE_SEND_MAIL Sen&d Send the active document
Mail... through electronic mail\n
Send Mail

Now insert a string that provides explanatory text on the status bar into
the application’s string table. I assume you are also familiar with adding string

29



PART I: WORKSHOP

resources to an application, so I'll provide you only the values you need. The
position of the values is not important in the string table. After you have
made these additions, save the resource file.

String Table Properties

ID Caption

IDP_SOCKETS_INIT_FAILED Windows Sockets initialization failed.

Step 2: Adding Support Code

Now you have to add code to a few of the project’s files. Because the features
to be added are related to the document class and the main frame window
class, we work mainly with the classes CProjNameDoc and CMainFrame. To add
support code for Windows Sockets, follow this procedure:

1. Add the following include file—which consists of standard code that
initializes and implements Windows Sockets support—to the end of
your project’s STDAFX.H header file:

#include <afxsock.h> // MFC socket extensions

2. Add the resource symbol IDP_SOCKETS_INIT_FAILED, which tells
the framework if the application fails to initialize the Windows
Sockets.

Follow the procedure below to add the resource symbol using the Re-
source Includes dialog box. When you are finished, save the resource file.

1. Load your project’s workspace.

2. Choose Resource Symbols from the View menu.
3. Click New.
4

. For Name, enter IDP_SOCKETS_INIT_FAILED, and for Value, enter
104.

5. Click OK to dismiss the New Symbol dialog box, and click Close to
dismiss the Resource Symbols dialog box.

The last modification related to MAPI support involves the manual addi-
tion of command handlers for the new Send command. You will have to add
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an ON_COMMAND_UPDATE_UI handler as well as an ON_COMMAND han-
dler. The ON_COMMAND handler sends the current document to a mail ap-
plication specified by Windows. The ON_COMMAND_UPDATE_UI handler
updates the menu item, whether a mail application is available or not. Add
the following code immediately after the AFX_MSG_MAP portion map of
the document’s class. The message map can be found in the document’s im-
plementation file:

ON_COMMAND(ID_FILE_SEND_MAIL, OnFileSendMail)
ON_UPDATE_COMMAND_UI(ID_FILE_SEND_MAIL, OnUpdateFileSendMail)

At this point, you have completed installing MAPI support. To complete
the support for Windows Sockets, add initialization code to the application.
A good place to do this is in the InitInstance function of the CMainFrame class,
which was derived from CFrameWnd. Add the following code to the beginning
of InitInstance:

if (1AfxSocketInit())

{
AfxMessageBox(IDP_SOCKETS_INIT_FAILED);
return FALSE;

}

Notice that the new resource string displays a message box if the Windows
Sockets initialization fails.

Additional Information

Now that you have Windows Sockets support, you might want to read a few ar-
ticles about implementing a socket client or server. In the Visual C++ online
documentation, read the Windows Sockets in MFC family of articles in “Pro-
gramming with MFC.”

Converting an Existing
MFC SDI Application to MDI

The purpose of this task is to convert an existing application’s interface from
SDI to MDI. (This task does not apply to dialog box—based applications.) The
task has six steps:

1. Creating a new child frame menu and add resources

2. Modifying the main frame menu

3. Replacing the main frame window
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4. Adding child windows to the project
5. Modifying the initialization code of the main frame window

6. Modifying the application’s execution

WARNING: This task makes significant structural changes to
the SDI application that is being converted. I cannot guarantee
that the application will function properly after you make the con-
version, so I recommend that a copy of the project be used in case
the conversion does not work.

When I refer to a “target project” in this task, I am referring to the project
you are converting. When a project name is needed for the examples, the proj-
ect name PROJNA is used.

Step 1: Creating a New Child Frame Menu and Adding Resources
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The main difference between SDI and MDI applications is that MDI applica- -
tions can support multiple child frame windows. Because of this difference,
MDI applications need two menu resources. The first menu, which is often
called IDR_MAINFRAME, is used when no child windows are open. The ex-
isting menu resource of the target project (Figure 1-11) will be used for this
purpose. This menu is basically a shorter version of the standard SDI menu
without the Save operations of either the File menu or the Edit menu that are
generated by AppWizard.

The second menu, or child frame menu, is used when one or more
child windows are open (Figure 1-12). This menu resource (whose ID is often
IDR _<name of project>TYPE—for example, IDR_PROJNATYPE) has the Edit
menu, a Windows menu that can perform common MDI operations (such as
creating a new window or arranging multiple child windows) and possibly other
commands that are specific to the child windows as well.

To make things as easy as possible, make a copy of the application’s ex-
isting menu (named IDR_MAINFRAME) and then modify the copy. For this
task, the child frame menu resource will have the ID IDR_PROJNATYPE. To
create the child frame menu, follow these steps:

1. Go to the target project’s Resource pane, and expand the Menu
node.

2. Right-click the IDR_MAINFRAME menu, and drag and drop a copy
into the same node. You should now have a copy of the IDR_MAIN-
FRAME menu named IDR_MAINFRAMEL.
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g »DefaullMDlApp

Figure 1-11.
The default main frame window menu of an MDI application.

Figure 1-12.
The default child frame menu of an MDI application.
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3. Rename the new menu resource IDR_PROJNATYPE.

4. From the File menu of the IDR_MAINFRAME resource, remove the
Close, Save, Save As, Print, and Print Preview commands.

5. Remove the entire Edit menu of the IDR_MAINFRAME resource.

6. Confirm the menu changes by saving the resource file of the target
project.

7. Add a Window menu between the View and Help menus.
This menu allows the user to manipulate open child windows in vari-
ous ways, such as cascading or tiling them. I assume you are familiar
with adding menu resources to a project, so I will provide you with
just the ID, the caption, and the prompt for each command.

Information for Window Menu Items

Resource ID Caption Prompt
ID_WINDOW_NEW &New Open another window
Window for the active docu-
ment\nNew Window

ID_-WINDOW_CASCADE &Cascade  Arrange windows so
they overlap\nCascade
Windows

ID_WINDOW_TILE_HORZ &Tile Arrange windows as
non-overlapping
tiles\nTile Windows

ID_WINDOW_ARRANGE &Arrange  Arrange icons at the bot-
Icon tom of the window\n
Arrange Icons

You can also copy a Windows menu from another project, but be
sure it has only the following four commands: New Window, Cascade,
Tile, and Arrange Icons.

Adding a String Resource

Because the second menu resource, IDR_PROJNATYPE, requires a resource
string of the same name, this resource string must be added to the project.
The following string is an example of a new string resource:

\nProjna\nProjna\n\n\nProjna.Document\nProjna Document
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Replace all occurrences of Projna with the name of your project. This
string will be used in a later piece of code to tie resources to the modified
document template that uses the MDI child window class.

Adding Other Child Frame Icons

The child frame window also needs an icon resource. This icon can be copied
from another source or created. However, for the icon to be used for the ap-
propriate child frame window, it must have the same ID as the child window
menu and string resource. In this case, the ID is IDR_PROJNATYPE.

Step 2: Modifying the Main Frame Menu

The purpose of this step is to modify the main frame menu so that all com-
mands that depend on an open document or an active window are moved to
the child frame menu IDR_PROJNATYPE. This ensures that any commands
of this type are available only when a child window is open.

In this step, if the target project’s main frame menu has changed signifi-
cantly from the standard version generated by AppWizard, the potential ex-
ists for resource ID conflicts and confusion. For the purposes of this
discussion at this point, I will assume that the existing main frame menu has
not changed significantly from the standard generated by AppWizard. If the
menu does not have the commands being discussed, skip to the next step.
Once again, itis a good idea to back up the project you are converting in case
you have to restore the project to its initial state. To modify the main frame
menu, follow this procedure:

1. Open your menu resource, and remove the Save and Save As com-
mands from the File menu.

2. Move any other commands that require an open document or an active
window from the File menu to a corresponding place on your child
frame menu resource. You can move these items to a corresponding
place in the IDR_PROJNATYPE menu by cutting and pasting each
menu item to the child frame menu. A quick way to move these menu
items is to drag each (while holding down the right mouse button) to
the proper place on the child frame and drop it. A context menu
should appear when the command is dropped. To move the menu
item, choose the Move option.

3. If the main frame menu has an Edit menu, expand it.

4. If the Edit menu contains only the Undo, Cut, Copy, and Paste com-
mands, remove the entire menu. If the Edit menu contains more
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“than these four commands, remove the Undo, Cut, Copy, and Paste

commands and also all other commands that require an open docu-
ment or an active window. Commands that do not fall under this cate-
gory can remain.

. For each remaining menu, move any commands that require an

open document or an active window to their corresponding location
on the child frame menu. These menu items depend on a window
(such as a child window) being open; if you don’t move them, they
will be available when the application has no child windows open.
Thus, if the user chooses menu items that depend on an open child
window, the application could crash in a big way because there are no
MDI child windows with which to interact at this point.

. After you finish modifying any additional commands, save the project’s

RC file. At this point, you should have two menu resources: IDR-
_MAINFRAME and IDR_PROJNATYPE.

Step 3: Replacing the Main Frame Window

There is a fundamental difference between the main frame window of an SDI
application and the main frame window of an MDI application. In order to
support the additional functionality of child windows, the main frame win-
dow’s class should be derived from CMDIFrameWnd instead of CFrameWnd.
The following procedure changes the parent of the main frame window class
to CMDIFrameWnd.
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E In the MAINFRM.H header file, change the following line

class CMainFrame : public CFrameWnd

to

class CMainFrame : public CMDIFrameWnd
and replace

protected: // create from serialization only
CMainFrame();
DECLARE_DYNCREATE(CMainFrame)

with
DECLARE_DYNAMIC(CMainFrame)

public:
CMainFrame();
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N In the MAINFRM.CPP file, search for CFrameWnd and replace it with
CMDIFrameWnd. In the same file, replace the following line

IMPLEMENT_DYNCREATE(CMainFrame, CFrameWnd)
with
IMPLEMENT_DYNAMIC(CMainFrame, CMDIFrameWnd)

If you are the inquisitive kind, you might be wondering why the main
frame window class is modified to use DECLARE_DYNAMIC instead of
DECLARE_DYNCREATE. There are two reasons for this change—one root-
ed in the actual code generated by AppWizard, the other in the architecture
of the two application types.

The Architectural Reason

In an SDI MFC application generated by AppWizard, the main frame window
class is related to a specific document and view via a document template. For
the application to start, a main frame window and a document-view pair must
both be dynamically created simultaneously. This dynamic creation is made
possible by the DECLARE_DYNCREATE macro. However, in the case of
MDI applications, the main frame window is not related to any document
template and can be created explicitly without its also having to create a
matching document-view pair. Instead of being related to the main frame
window, the document-view pairs are related to a child window. This sepa-
rates the creation process and allows us to create just the main frame window
initially. Therefore, the DECLARE_DYNAMIC macro is sufficient.

The Code Reason

In both SDI and MDI applications, the main frame window is created in the
InitInstance function of the application class. However, in an SDI application,
we don’t actually create the main frame window. The main frame window is
created because of a “request” from the document template of the applica-
tion. And it just so happens that the DECLARE_DYNCREATE macro enables
the creation of the frame window in this manner.

In the creation of an MDI application, the main frame window is created
explicitly in the InitInstance function. Therefore, the class doesn’t need the
ability to be created dynamically. We can instead use the macro
DECLARE_DYNAMIC. This macro enables the main frame window class to
return run-time class information to other classes upon request.
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Step 4: Adding Child Windows to the Project

For your MFC application to display child windows, you must have a class that
implements an MDI child window. This class, derived from CMDIChildWnd,
implements frame window capabilities, along with some enhancements re-
lated to MDI support. Either you can use ClassWizard to add a CMDIChildWnd-
derived class to the target project for this step, or you can copy an existing
MDI child window class. If you use ClassWizard, the template class is similar
to the one created by AppWizard when the MDI option is chosen. If you use
an existing class, copy both the header and implementation files (in this ex-
ample, CHILDFRM.H and CHILDFRM.CPP) to the target project’s main direc-
tory, and add them to the target project using the Files Into Project command
from the Insert menu of Developer Studio.

After you have added the files to the project, include the header file of
the new child window class in the implementation file of the project’s appli-
cation class. This allows the application’s class access to the CChildFrame class
when initializing the document templates of your project in the InitInstance
function. In addition, change the following line (near the top in the new
child window class) to point to the application class’s header file in your
project:

#include "projname.h”

Step 5: Modifying the Initialization Code
of the Main Frame Window
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Now that you have added a new class and resources and have changed the
derivation of the frame window, the initialization code must be updated to
use this new functionality. Make these modifications in the InitInstance func-
tion of the project’s application class. The InitInstance function is responsible
for registering and initializing all of the application’s document templates.
There are three parts to this process: modifying the document template ini-
tialization, creating the main frame window, and showing the window.

1. To modify the document template initialization, change the follow-
ing lines in the implementation file of the project’s application class

CSingleDocTemplate* pDocTemplate;

pDocTemplate = new CSingleDocTemplate(
IDR_MAINFRAME,
RUNTIME_CLASS(CMyProjDoc),

to



ONE: AppWizard and the MFC Library

CMultiDocTemplate* pDocTemplate;

pDocTemplate = new CMultiDocTemplate(
IDR_PROJNATYPE,
RUNTIME_CLASS(CMyProjDoc),

The bold code lines indicate where the code has changed. This code
performs the first part of document template initialization (pDocTem-
plate). It sets up a relationship between a document class (CMyProjDoc),
a view class (CMyProjView), and a frame window class (CChildFrame).
This relationship is used by the application framework when a new
window needs to be created. The template tells the application frame-
work what view class goes with the document class and the frame win-
dow class.

Now change the frame window class from your original SDI type
of class (CMainFrame) to the new MDI class (CChildFrame). In the im-
plementation file, change the following lines

RUNTIME_CLASS(CMainFrame), // Main SDI frame window
RUNTIME_CLASS(CMyProjView));
AddDocTemplate(pDocTemplate);

to

RUNTIME_CLASS(CChildFrame), // Custom MDI child frame
RUNTIME_CLASS(CMyProjView));
AddDocTemplate(pDocTemplate);

. Immediately after these modifications, replace these lines of code

// Parse command line for standard shell commands, DDE, file open
CCommandLineInfo cmdInfo;
ParseCommandLine(cmdInfo);

// Dispatch commands specified on the command line
if (!ProcessShellCommand(cmdInfo))
return FALSE;

with these lines of code:

// Create main MDI frame window

CMainFrame* pMainFrame = new CMainFrame;

if (!pMainFrame->LoadFrame(IDR_MAINFRAME))
return FALSE;

m_pMainWnd = pMainFrame;

This code creates the “container” for your MDI child windows and
initializes the default menu for the application.
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3. Finally, just before the end of the InitInstancefunction, add the follow-
ing lines:
// The main window has been initialized, so show and update it

pMainFrame->ShowWindow(m_nCmdShow) ;
pMainFrame->UpdateWindow();

This code simply shows the main frame window and repaints it to
update it.

Step 6: Modifying the Application’s Execution
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After you’ve made all of the recommended modifications, it’s a good idea to
build the project and fix any compilation and linking errors that occur.
When you have a clean compilation, you can move on to the final step, modi-
fying the application’s execution, which is the most difficult step of the entire
task. Because you have modified the fundamental structure of your applica-
tion by converting it to an MDI application, the following assumptions that
were made by the developer in the SDI version are no longer correct:

# The application’s client window is always open and active. (It might
not be.)

# The application’s active frame window is the main window
m_pMainWnd. (Its active frame window can be either the application
frame window or a child frame window.)

# The main frame window is used to retrieve the client window. (You
must call GetActiveFrame and then call GetActiveView to retrieve the cli-
ent window.)

The original assumptions for an SDI application will now produce many as-
sertions and errors, and in some cases they might cause immediate termina-
tion of the application. However, if you correct the sources of assumptions
one at a time, you should be able to eliminate the majority of errors quickly.

One example of this is to check for any message handling that is sent im-
mediately upon application initialization. Good examples of this are the mes-
sage handlers for the WM_IDLE and WM_QUERYNEWPALETTE messages.
If you are handling any messages of this type, check the code for assumptions
regarding the application state (such as the existence of a document object or
an active and visible child window). For every case, you must modify the code to
check for these situations and handle them appropriately. For example, the
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following WM_IDLE message handler was taken from an SDI sample pro-
gram; it updates a status bar pane with the current cursor location in the
document.

BOOL CNotepadApp::0nIdle(LONG 1Count)

{
CMainFrame* pFrame = (CMainFramex) AfxGetMainWnd();
CStatusBar* pStatusBar = (CStatusBarx) pFrame->
GetDescendantWindow(AFX_IDW_STATUS_BAR);
if (pStatusBar)
{
CEdit &edit = ((CEditView*)pFrame->GetActiveView())->
GetEditCtri();
CString si;
UINT i = edit.LineFromChar();
sl.Format(_T("Ln %u"), ++i);
pStatusBar->SetPaneText(pStatusBar->
CommandToIndex(ID_INDICATOR_LINE), sl1);
}
return CWinApp::0nlIdie(1Count);
}

The following line of code from the example above indicates that the
application assumes there will always be an active view:

CEdit &edit = ((CEditView*)pFrame->GetActiveView())->
GetEditCtr1();

This is a bad assumption in an MDI application because at times there might
not be any child windows open. If you were to execute this code, you would
get an assertion when the LineFromChar function is called. To make the code
work properly, format the status bar only if an active view is present. The
modified code (shown in bold) might look something like this:

BOOL CNotepadApp::0nIdle(LONG 1Count)
{
CMainFrame* pFrame = (CMainFrame*) AfxGetMainWnd();
CStatusBar# pStatusBar = (CStatusBar*) pFrame->
GetDescendantWindow(AFX_IDW_STATUS_BAR);

// If no active child frame windows are open,

// a pointer to the main frame window is returned

CChildFrame* pChildFrm= (CChildFrame*)pFrame->
GetActiveFrame();

CEditView* pView= (CEditView*)
(pChildFrm->GetActiveView());

(continued)
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if (pStatusBar && pView != NULL)
{
CEdit &edit = pView->GetEditCtrl();
CString sl;
UINT i = edit.LineFromChar();
sl.Format(_T("Ln %u"), ++i);
pStatusBar->SetPaneText(pStatusBar->
CommandToIndex(ID_INDICATOR_LINE), sl);
}
return CWinApp::0nIdie(1Count);

If the status bar or the view objects aren’t present, you should probably
call the message handler of the parent class and fall out without performing
any action. Notice the call to GetActiveFrame; you will probably use this call
when checking for the presence of child windows. It returns the active MDI
frame window and, if there is no active MDI child, returns the implicit this
pointer.

A second assumption of an SDI application is that the active frame win-
dow of the application is the main window; it fails in an MDI application be-
cause of the additional level of indirection regarding frame windows. In the
case of your converted application, there are now two possible frame win-
dows—an application frame window and a child frame window. In the SDI
version of the application, the frame window was used either to access mem-
bers of the frame window, such as the control bars, or to access the active
view. However, in the MDI version of the application, you must determine
whether you are accessing members of the main frame window or accessing
views of the application. In the preceding code sample where the status bar is
being updated, the first few lines work properly because the application’s
control bars are being accessed. However, the next few lines do not work be-
cause the code is trying to access the active view via the application’s frame
window. In MDI applications, you will never get an active view from the appli-
cation’s main frame window. You must go down one more level using GetAc-
tiveFrame, and then retrieve the view.

This leads nicely into a third assumption in SDI applications: that the
active frame and view are retrieved using the main frame window. This can-
not work in an MDI application. In most cases, the code that assumes this can
be found easily by searching the source files for instances of AfxGetMainWnd
and m_pMainWnd. These calls will function properly only if the control bars
or the data members of the main frame window class are being accessed. If
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the active view or related object is being accessed, you have to address the
added level of indirection by making a call to the GetActiveFrame function of the
frame object and then using GetActiveView or similar calls to retrieve the active
view. Once again, check for the presence of an active view before handing off
the result.

To recap, check your application’s code for the following:

W Message handlers that are called upon initialization
B Situations in which a view is assumed to exist

B Code that retrieves the active view using AfxGetMainWnd or
m_pMainWnd

In each case, ensure that the additional level of indirection regarding frame
windows in MDI applications is addressed or that return values from calls are
checked for valid views.

TIP: Search the source code files for occurrences of active,
frame, and view code because this is usually code that was affected
in some way by the conversion from SDI to MDI.

If you have successfully completed the conversion of your application,
you should now be able to build and run it. In most cases, it should run with
few or no problems. However, I highly recommend that you test the function-
ality of your application extensively.
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CHAPTER TWDO

Application and
Frame Window Architecture

The focus of this chapter is the application and frame window classes of an
MFC application. As I mentioned in Chapter 1, the application object is the
“core” of an MFC application. It is located in the primary layer and works
closely with the document, view, and frame window objects. Although it is “in-
visible,” it has features that are of interest to us. The frame window is a pri-
mary object that is more visible. It’s more closely related to the application
than either the document object or the view object and interacts with both the
application and the document-view pair—it can be viewed as the “interface”
between the application and the document-view pair.

The tasks included in this chapter relate in some way to either the appli-
cation object or the frame window object. The following is a listing and brief
description of the tasks:

E Modifying the system menu of an MFC application Modifies the sys-
tem menu in various ways, including adding new menu commands
and modifying existing menu commands.

B Modifying the initial state of an MFC application Demonstrates spe-
cific methods for initially minimizing or maximizing the application
when it’s first displayed and for altering the size and placement of the
main frame window of the application.

B Adding a progress indicator to the status bar Demonstrates the im-
plementation of a progress indicator in the first pane of the applica-
tion’s status bar.

B Adding tooltips for modal dialog box controls Demonstrates the im-
plementation of tooltips for controls in a modal dialog box. Also
demonstrates routing messages with respect to tooltips for controls
in a modal dialog box using a nonstandard approach.
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B Animating a bitmap in the status bar Demonstrates the implementa-
tion of an animated 16-color bitmap in the status bar of an MFC ap-
plication. This bitmap, a spinning CD, is animated in its own pane
using a four-step process.

Modifying the System
Menu of an MFC Application

The purpose of this task is to modify the system menu (sometimes referred to
as the control menu) of an MFC application and to demonstrate some of the
more popular types of system menu modifications. Modifying the system
menu can provide additional information or attributes when the application
(or child window) is minimized. For example, you can add a command that
indicates the status of the application or a command that accesses a dialog
box without having to restore the application and go through the main menu.
I will discuss two types of modifications: modifications that are made to the
system menu during initialization of the application and dynamic modifica-
tions that can occur whenever the system menu is accessed. Specifically, I will
demonstrate how to add new commands, modify existing commands, and
perform dynamic modifications. In MDI applications, the child window sys-
tem menu also can be modified. Although the approach to modifying a child
window system menu is similar to the approach to modifying the main system
menu, there are some important differences, which are discussed in step 2 of
this task.

Modifying the system menu of an MFC application consists of three steps:

1. Modifying the main system menu
2. Modifying the child window system menu
3. Handling the WM_SYSCOMMAND message

This task’s project name is SYSMENU, and there are no requirements.

Step 1: Modifying the Main System Menu
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The primary reason for modifying the main system menu is to expose the ap-
plication attributes or the status of some task while the application is mini-
mized so that the user can access commands without restoring the application.
For example, the user might need to see the status of a lengthy process or a
command that invokes a dialog box while the application remains minimized.
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There are many other examples, but I leave those to the reader to discover as
an exercise.

NOTE: The procedure for modifying the main system menu is
the same for both SDI and MDI applications.

Initial Modification

Commands that are not dynamic or that do not change have to be modified
only once. For example, you would modify a command string, such as chang-
ing “Restore” to “My Restore” just once. Similarly, you would add a command
that is available at all times, such as the command that invokes the About dia-
log box of the application, just once. Your first chance to modify the main sys-
tem menu occurs after the main frame window has been created. In both SDI
and MDI applications, this occurs in the OnCreate function.

You can retrieve a copy of the system menu with a call to the CMenu.:Get-
SystemMenu function. This function takes a BOOL value as the only parame-
ter. Because you want to modify the menu, you pass a value of FALSE. When
you have a copy, make any desired modifications using member functions of
the CMenu class.

An example of initial modification is the following: In the SYSMENU
project, I modify the main system menu by changing the first command and
appending a command that invokes the About box of the application. These
modifications are made in a function named ModifySysMenu, which is called
in the main frame’s OnCreate function. The following code is taken from the
body of the ModifySysMenu function:

CMenu* pSysMenu = GetSystemMenu(FALSE);
CMenux* pFrameMenu = GetMenu();

CString tmpStr;

UINT curPosID;

//- Change the Restore command string

pSysMenu->GetMenuString(@, tmpStr, MF_BYPOSITION);

tmpStr = "My "+ tmpStr;

curPosID = pSysMenu->GetMenultemID(0); ,

pSysMenu->ModifyMenu(@, MF_BYPOSITION | MF_STRING, curPosID,
tmpStr); .

// Append the About box command
pSysMenu->AppendMenu(MF_SEPARATOR) ;
pFrameMenu->GetMenuString(ID_APP_ABOUT, tmpStr, MF_BYCOMMAND);
pSysMenu->AppendMenu(MF_STRING, ID_APP_ABOUT, (LPCTSTR)tmpStr);
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In the first section of the preceding code, I retrieve the system menu and
the main frame window menu. In the second section of code, I modify the first
command by adding the prefix “My” to the Restore command. The result, “My
Restore,” replaces the original string. The menu ID remains unchanged. In the
final section, I append the About box command to the menu, which allows
the user to invoke the About dialog box with one click when the application
is minimized.

NOTE: For new commands to execute properly, you must han-

dle the WM_SYSCOMMAND message. This is discussed in step 3 of

this task.

Dynamic Modification

Dynamic modification is useful for commands that must be checked before
the system menu is displayed. These commands are available or disabled, de-
pending on the changing conditions in the application. Examples include
disabled Maximize or Minimize commands or applications that close only
when certain conditions are met, such as the completion of a form or other
action. Because these conditions can change at any time, they must be
checked every time a user requests the system menu.

MFC provides a message (WM_INITMENU) that indicates the system
menu is about to be accessed. The message is sent before the system menu is
shown. To modify the system menu, add a handler for the WM_INITMENU
message to your main frame class. In most cases, this class is CMainFrame. Af-
ter you have installed the handler, you can access the system menu and make
the necessary modifications. Or you can restore the default system menu by
calling GetSystemMenu with a parameter value of TRUE. The following code sam-
ple is taken from the WM_INITMENU handler of SYSMENU’s main frame class:

CMDIFrameWnd: :0OnInitMenu(pMenu);

// Retrieve copy of system menu
CMenu* pSysMenu = GetSystemMenu(FALSE);
UINT curPoslID;

// Disable Maximize command

// To complete disablement, handle WM_SYSCOMMAND
curPosID = pSysMenu->GetMenultemID(4);
pSysMenu->EnableMenultem(curPosID, MF_GRAYED);

This code sample disables the Maximize command. However, to ensure that
the user cannot maximize the application, you must also handle the case of
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SC_MAXIMIZE in the handler for WM_SYSCOMMAND. The handler is dis-
cussed in step 3 of this task.

Step 2: Modifying the Child Window System Menu

In MDI applications, another system menu appears on every MDI child win-
dow. The same types of modifications that can be made to the main system
menu also can be made to child system menus; and, with some small changes,
the same procedures can be used to make these modifications.

Initial Modification

The system menu of a child window is first accessible after the child frame has
processed the WM_CREATE message. To access the menu at this time, add a
handler to your child frame window class for the WM_CREATE message. Any
modification of the child window system menu must occur after the call to
the base class’s OnCreate function. To improve the readability of the SYS-
MENU project, all modifications are made with a call to ModifySysMenu. The
following example, taken from the child frame class, demonstrates this:

int CChildFrame::0nCreate(LPCREATESTRUCT 1pCreateStruct)

{
if (CMDIChildWnd::0OnCreate(ipCreateStruct) == -1)
return -1;
ModifySysMenu();
return 0;
}

An example of an initial modification is the following: the code shown
below is taken from the child frame’s ModifySysMenu, and it demonstrates
some of the ways to initially modify the child frame system menu:

CMenu* pSysMenu = GetSystemMenu(FALSE);
CString tmpStr;

// Add Next window command
pSysMenu->AppendMenu(MF_SEPARATOR) ;

tmpStr = "Nex&t\tCtrl+F6";
pSysMenu->AppendMenu(MF_STRING, SC_NEXTWINDOW, tmpStr);
pSysMenu->AppendMenu(MF_SEPARATOR) ;

// Add tiling and cascading commands

tmpStr = "Casca&de A11";
pSysMenu->AppendMenu(MF_BYPOSITION | MF_STRING,

(continued)
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ID_WINDOW_CASCADE, tmpStr);
tmpStr = "Ti&le AT1";
pSysMenu->AppendMenu(MF_BYPOSITION | MF_STRING,
ID_WINDOW_TILE_HORZ, tmpStr);

In the first section of this example, I retrieve the system menu. In the second
section, I add the Next command to my copy of the system menu, which allows
the user to activate the next child window. This is necessary because retrieving a
copy of the system menu with FALSE as the argument to GetSystemMenu erases
this command. In the third section, I add two commands from the main menu:
Cascade and Tile. I modify the menu strings slightly by adding “All” to the
end of each string. The new strings are appended to the system menu, along
with a separator that makes the menu more legible. Note that the command
IDs for these two items are exact copies of the IDs for the Cascade and Tile
commands.

Dynamic Modification

The reasons for making dynamic modifications to the main system menu ap-
ply also to child frame system menus. The following code sample is taken
from the WM_INITMENU handler of SYSMENU’s main frame class:

CMDIChildWnd::OnInitMenu(pMenu);

CMenu* pSysMenu = GetSystemMenu(FALSE);

UINT curPosID;

if (IsIconic()) // Disable tiling and cascading when
// minimized

{
curPosID = pSysMenu->GetMenultemID(10);
pSysMenu->EnableMenultem(curPosID, MF_GRAYED);
curPosID = pSysMenu->GetMenultemID(11);

. pSysMenu->EnableMenultem(curPosID, MF_GRAYED);

}

else // Enable if window is normal or maximized

{
curPosID = pSysMenu->GetMenultemID(10);
pSysMenu->EnableMenultem(curPosID, MF_ENABLED);
curPosID = pSysMenu->GetMenultemID(11);
pSysMenu->EnableMenultem(curPosID, MF_ENABLED);

) :

The main item of interest here is the if-else block, which disables the Cascade
All and Tile All commands only when the child window of the system menu be-
ing accessed is minimized. If the child window is normal or maximized, the
Cascade All and Tile All commands are enabled.
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NOTE: For new commands to execute properly, you must han-
dle the WM_SYSCOMMAND message. This is discussed in step 3.

Step 3: Handling the WM_SYSCOMMAND Message

Unlike what occurs with standard menu commands, a WM_SYSCOMMAND
message is sent every time the user chooses an item from the system menu.
And every time a user chooses the maximize or minimize button, a WM_SYS-
COMMAND message is posted. One of the message parameters is the com-
mand ID of the command chosen. To intercept events from the system menu,
you must handle the WM_SYSCOMMAND message and take appropriate ac-
tion for both custom commands and items that you have modified, such as a
disabled Maximize command. If you do not handle these customizations, the
command will be handled by the framework, which knows nothing about
your modifications.

Now add the handler if you have made any changes beyond modifying
command strings. For main system commands, the handler must be imple-
mented in the main frame class; for child window system commands, the han-
dler must be implemented in the child frame class. In the SYSMENU project,
the code handles WM_SYSCOMMAND for both frame window objects.

After you have added the handler, check for your modified or new com-
mands. To do this, compare the ID passed in against your set of modified or
new command IDs. For example, in the SYSMENU project, I added an About
SysMenu command; therefore, I had to check for the command ID (ID_APP-
_ABOUT) and then make a call to CSysMenuApp::OnAppAbout to make the
About SysMenu dialog box appear. The following code, taken from the body
of CMainFrame::OnSysCommand, demonstrates the basic process:

CSysMenu2App* pApp = (CSysMenu2App=*)AfxGetApp();

switch(nID)
{
case SC_MAXIMIZE:
break;
case ID_APP_ABOUT:
{
pApp->0nAppAbout();
break;
}
default:
CMDIFrameWnd: :OnSysCommand(nID, 1Param);

51



PART 1: WORKSHOP

In the preceding example, I checked for the Maximize (SC_MAXIMIZE)
command and the About SysMenu (ID_APP_ABOUT) command. In the case of
SC_MAXIMIZE, I ignore the command and return nothing because I disabled
the Maximize command for the application. This prevents the user from
maximizing the application with either the system menu or the Maximize but-
ton. In the case of ID_APP_ABOUT, I get a pointer to the application and call
the appropriate function. In all other cases, I relay the message to the parent
window.

I use the same procedure for the system menu of the child window. The
following code checks for the Cascade All and Tile All commands and calls the
appropriate functions. The code is taken from the body of the CChildWnd::-
OnSysCommand function:

// Handle the tiling and cascading commands
switch(nID)
{

case ID_WINDOW_TILE_HORZ:

(
GetMDIFrame()->MDITi1e(MDITILE_HORIZONTAL);
break;

}

case ID_WINDOW_CASCADE:

{

GetMDIFrame()->MDICascade();
break;

}

default:

CMDIChildWnd: :0OnSysCommand(nlID, 1Param);
}

In this example, I check for the Cascade All (ID-WINDOW_CASCADE) com-
mand and the Tile All ID_-WINDOW_TILE_HORZ) command. In both cases,
I retrieve a pointer to the main frame window and call the appropriate function.

Additional Information
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An additional modification to the CMainFrame::ModifySysMenu function can
be made that inserts a pop-up menu into your application’s system menu.
Add the following code to the end of your ModifySysMenu function:

// Set up a Window State pop-up menu item

CMenu popMenu;
popMenu.CreatePopupMenu();

pSysMenu->GetMenuString(SC_MAXIMIZE, tmpStr, MF_BYCOMMAND);
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popMenu.InsertMenu(®, MF_BYPOSITION, SC_MAXIMIZE, tmpStr);
pSysMenu->GetMenuString(SC_MINIMIZE, tmpStr, MF_BYCOMMAND);
popMenu.InsertMenu(@, MF_BYPOSITION, SC_MINIMIZE, tmpStr);

pSysMenu->InsertMenu(3, MF_BYPOSITION | MF_POPUP,
(UINT)popMenu.GetSafeHmenu(), "Window States");

pSysMenu->RemoveMenu(4, MF_BYPOSITION);

pSysMenu->RemoveMenu(4, MF_BYPOSITION);

In the first section of this code, I create a blank pop-up menu. In the next sec-
tion, I copy the existing menu strings for the Minimize and Maximize menu
commands into the new pop-up menu. Finally, I insert the new menu, named
Window States, into the system menu and then remove the original Minimize
and Maximize items to prevent duplication.

Modifying the Initial State of an MFC Application

The purpose of this task is to modify the initial appearance of an application
and its related windows. Attributes that can be modified include the auto-
matic minimizing or maximizing of an application and the size and place-
ment of application windows. In addition to demonstrating how to modify
the main frame window, I will also demonstrate how to make these same modi-
fications on MDI child windows. To fully demonstrate possible customiza-
tions, I will use an MDI application. The name of the project is CUSTOM, and
there are no requirements.

Modifications to SDI Applications

For SDI applications, you can modify the attributes of the main frame (or ap-
plication) window. Common customizations include modifying the initial state
of the main frame window (whether the window is minimized or maximized)
and changing the size and the position of the window on the desktop.

Minimized or Maximized?

The initial state of the main frame window (maximized or minimized) can be
customized by modifying the InitInstance function of the main frame class.
The main purpose of this function is to display the main frame window. The
window style of the window object determines how the main frame window
appears when it is displayed, with the default being WS_SHOWNORMAL. This
style is stored in the public variable m_nCmdShow and can be modified easily
to display the main frame window in many ways. Make the modification im-
mediately after the call to ParseCommandLine of the main frame’s InitInstance
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function. The following code adds the SW_SHOWMAXIMIZED style to the
main frame window’s styles:

// Maximizes main window automatically
m_nCmdShow = SW_SHOWMAXIMIZED;

The code shown below adds the SW_SHOWMINIMIZED style to the main
frame window’s styles:

// Minimizes main window automatically
m_nCmdShow = SW_SHOWMINIMIZED;

After you’ve changed the style, the application takes care of the rest. More styles
can be found in the online documentation for Microsoft Visual C++ version 5.

Modifying the Initial Size and Position of the Main Frame Window
In addition to modifying the initial state of the main frame window, you can
customize the size and the position of the window before the application first
appears. The size and the position, along with other window characteristics,
are stored in a CREATESTRUCT structure, which is used to create the new
window object. In applications created by AppWizard, the PreCreateWindow
member function of the main frame and view windows is automatically over-
ridden by AppWizard. This provides access to the CREATESTRUCT structure
before the window is created.

The following code sample sets the window size to half the screen size
using ::GetSystemMetrics, and then it centers the window:

// Size the window to 1/2 screen size, and center it
cs.cy ::GetSystemMetrics (SM_CYSCREEN) / 2;

CS.CX ::GetSystemMetrics(SM_CXSCREEN) / 2;

cs.y =cy / 2; :

cs.Xx = ¢cs.cx / 2;

This type of code is usually found before the call to the base member function.

Modifications to MDI Applications
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In addition to the main frame and view objects, MDI applications also have
child window objects. Therefore, in addition to modifying attributes of the
main frame window, you also can modify attributes of the child window. How-
ever, MDI applications have a client area, generally referred to as the MDI-
CLIENT area, where the child windows appear. The addition of the client
area and the child window objects in an MDI application requires changing
the procedures used to modify SDI applications so they will work for an MDI'
application. A self-centering MDI application is shown in Figure 2-1.



TWO: Application and Frame Window Architecture

i Lt
e Control Parel FE Dueny

< Custom - Custom1

OEEiEPEiEEE

B Custom1

D} Esplorer

Figure 2-1.
A centered MDI application using screen size calculations.

Minimized or Maximized?

The procedure for automatically minimizing or maximizing the main frame
window of an MDI application is identical to the procedure used for an SDI
application except that the code is placed in a different location. Instead of
placing the minimize/maximize code after the call to the ParseCommandLine
function of the application’s InitInstance function, place it just before the call
to ShowWindow that shows the main frame window.

However, if you want the same effect for child windows, a little more
work is required. The easiest way to customize the initial state of a child win-
dow is to override the ActivateFrame function of the child window class, which
is usually named CChildFrame. This function is called by the framework before
the frame window is visible. In your override of the ActivateFrame function,
add the following code right before the call to the base class version:

nCmdShow = SW_SHOWMINIMIZED;
This causes all child windows to appear minimized initially. To display maxi-
mized child windows, use SW_SHOWMAXIMIZED.

Initial Size and Position of the Main Frame and Child Windows
Because of the similarities between the architectures, you can use the same
procedures you used for SDI applications to customize the MDI main frame
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window and the MDI child windows. Because applications created with App-
Wizard automatically override the main frame and child window PreCre-
ateWindow functions, all that’s left to do is to add code exactly like the SDI size
and position code that sets the size and the position of the main frame or child
windows. However, be careful when calculating the client area of the main
frame window. Once again, the MDI architecture is the reason behind this
warning. As with SDI applications, there is a client area bounded by the main
frame window. In a typical SDI application, the client area is completely cov-
ered by the view window object, hence, the name single document interface.

However, the client area of an MDI application can be partially or com-
pletely visible at certain times, depending on the state of the child windows
and any control bars. This means that a call to the GetClientRect function of
the frame window returns a rectangle that does not account for the presence
of tool or status bars. Therefore, if you try to center a child window using the
normal calculations (in the child’s PreCreateWindow function), the child will not
be centered because the client area is calculated only after the application
becomes visible: '

CRect client;
CMDIFrameWnd* pFrame = (CMDIFrameWnd*) AfxGetMainWnd();

// Size the window to 1/2 screen size, and center it
pFrm->GetClientRect(&client);

cs.cy = client.Height() / 2;

cs.cx = client.Width() / 2;
_cs.y = ((cs.cy * 2) - cs.cy) / 2;

cs.x = ((cs.cx * 2) - ¢s.cx) / 2;

To get a centered child window, you must calculate the actual client area:
the client area minus the area of any visible control bars. Fortunately, the CM-
DIFrameWnd class has a public member, m_hWndMDIClient, that helps do just
that. Therefore, you can modify the calculation code slightly, as shown below.
The sample will then calculate the actual client area, taking into account the
presence of control bars.

CRect client;
CMDIFrameWnd* pFrame = (CMDIFrameWnd*) AfxGetMainWnd();

// Size the window to 1/2 screen size, and center it
::GetClientRect(pFrame->m_hWndMDIClient, &client);
cs.cy = client.Height() / 2;

cs.cx = client.Width() / 2;

cs.y = ((cs.cy = 2) - cs.cy) / 2;

cs.x = ((cs.cx * 2) - ¢s.cx) / 2;
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Unfortunately, there is still a slight problem with the code sample. The
m_hWndMDIClient data member is undocumented. This means that the be-
havior of this code could change in the future, so use it at your own risk. For
a related method of calculating the available client area, subclass the client
area and access the dimensions through the subclassed window. The Knowl-
edge Base article “How to SubClass the MDIClient by Using MFC”: Q129471
describes this procedure clearly and completely.

Adding a Progress Indicator to the Status Bar

The purpose of this task is to add a progress indicator to the status bar of an
application. A progress indicator can be used to indicate the time (or bytes)
remaining for the current process or as a visual indicator that the application
has not frozen or silently crashed. The progress indicator is implemented
with a CProgressCtrl class object and, when activated, covers the application
status bar’s first pane, which is reserved for status messages.

NOTE: To clearly demonstrate the implementation of the
progress indicator, this task (and the sample project) uses a simple
forloop to demonstrate the implementation of a progress control

_in the status bar. I refer to this for loop as the “Lengthy Process.”
The loop, and the related interface, are used here purely for dem-
onstration purposes only and are not intended as an example of a
“real world” situation.

In the sample project, you can view the progress indicator by choosing
the Lengthy Process command. When this occurs, the handler for the
Lengthy Process command retrieves the dimensions of the first pane and cre-
ates the common progress control within this area, as shown in Figure 2-2 on
the following page. When the forloop completes, the progress indicator is de-
stroyed and control of the first pane returns to the application.

The task consists of two steps:

1. Implementing the user interface

2. Creating and displaying the progress indicator

The Lengthy Process menu command, which invokes the progress indi-
cator control, is designed to demonstrate the progress indicator and is not a
required step in this task. In a standard application, the progress indicator is

invoked when a certain event, determined by the developer, begins. For this
reason, you can skip step 1, which sets up the interface used in the sample
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Figure 2-2.
A progress indicator, located in the first pane of the status bar.

project, and begin with step 2, which describes the code needed to implement
the progress indicator. The name of the sample project is STATUS, and there
are no requirements.

Step 1: Implementing the User Interface
Just for demonstration purposes, the sample project invokes the progress

indicator when the user chooses the Lengthy Process menu command. To add
the Lengthy Process command to the main menu, follow these steps:

1. Using the Resource Editor, add a menu command with the ID of
ID_LENGTHY_PROCESS to the View menu of your application’s
main menu. This menu item, when chosen by the user, starts the fake
process.

Properties of the Lengthy Process Menu Item

ID Caption Prompt
ID_LENGTHY_PROCESS &Lengthy Invokes the progress
Process indicator in the status
bar\nLengthy pro-

cess.

2. Add a separator right after the new command.
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3. Add a command handler for the new command to your application’s
CMainFrame class. The CMainFrame::OnLengthyProc function is the
handler used by the sample project.

4. Save the resource file.

Step 2: Creating and Displaying the Progress Indicator

The creation and display of the progress indicator in the application’s status
bar is fairly simple. First you retrieve the status bar of the application, and
then you calculate the size of the status bar’s first pane and create the progress
control and position it so that it covers the entire first pane. After the process
is finished, you destroy the control.

The code for displaying a progress indicator, found in the OnLengthyProc
function of the sample project, assumes that the status bar object of the main
frame window is accessible. In applications generated by AppWizard, the sta-
tus bar object (a protected data member of CMainFrame) is accessible only
from the CMainFrame class or a friend of the CMainFrame class. For this rea-
son, the code shown below must be added to the new command handler,
CMainFrame::OnLengthyProc.

// Create CProgressCtrl as a child of the status bar

// positioned over the first pane

RECT rc;

m_wndStatusBar.GetItemRect(@, &rc);

CProgressCtrl wndProgress;

VERIFY (wndProgress.Create(WS_CHILD | WS_VISIBLE, rc,
&m_wndStatusBar, 1));

wndProgress.SetRange(0, 50);

wndProgress.SetStep(1);

// Perform some lengthy process, simulated here with a for loop
// and the Sleep function
for (int i=0; i<50; i++)
{

Sleep(50);

wndProgress.Steplt();
}
In the first section of this code, I retrieve the dimensions of the status bar’s
first pane. I then create the progress indicator control, using the area of the first
pane and setting the parent of the progress control equal to the frame win-
dow. I set the range and the step sizes based on the for loop, which has 50 parts.
In the next code section, I use a for loop of 50 cycles to imitate a lengthy pro-
cess and step the progress indicator once for each for loop cycle.
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" After you add the code on the preceding page, rebuild your project. You
should now be able to display a progress indicator in the first pane of your ap-
plication’s status bar.

Adding Tooltips for Modal Dialog Box Controls
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The purpose of this task is to add tooltips to the controls of a modal dialog
box. Tooltips for the OK button, a static control, and the dialog box itself will
be implemented using the CToolTipCtrl class. By default, MFC provides tool-
tips for descendants of any frame window class derived from CFrameWnd. 1f
you want tooltips for other types of tools, such as other windows or rectangu-
lar regions, you’ll have to roll your own.

The method used to provide tooltip support in an MFC application uses
the common control class CToolTipCtrl. This class wraps the tooltip common
control and provides an adequate amount of default support (even though
the documentation is somewhat spare) to implement the common tooltips.
We will add a CToolTipCtrl class that is responsible for three “tools”—a toolbar
button, an embedded child window, or a rectangular region—to the applica-
tion class. To provide a more complete demonstration, we will add tooltips
for a button control, a static region, and the About dialog box. After the task
has been completed, the user will see the tooltips for the dialog box or any
controls inside automatically when the mouse cursor pauses over one of
them, as shown in Figure 2-3.

Figure 2-3.
Tooltip for a static control.

The task consists of three steps:

1. Modifying the modal dialog box
2. Modifying the OnlnitDialog and PostNcDestroy functions
3. Modifying the application class
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The project is named DLGTIPS, and the requirement is a modal dialog
box class used by the application. The sample project uses the About dialog box
generated by AppWizard.

Background

To implement a functioning tooltip in an MFC application, you must do all of
the following:

® Define the tools that will be monitored by the tooltip control.
@ Activate the tooltip control(s).
B Determine when to display the tooltip.

B Provide text to display in the tooltip window when text is requested
by the system.

The default support for tooltips is available only for controls (or tools)
embedded in a CFrameWnd-derived class or for a descendant of a CFrameWnd-
derived class. The reason for this is that CFrameWnd is the only class that pro-
vides a handler function for the TTN_NEEDTEXT notification. This notifi-
cation is sent by the framework when the mouse has remained on the same
point for about a half second and when there is a registered tool (usually a
toolbar button or a menu item) that includes the current mouse position.
When this situation exists, a TOOLINFO structure is initialized and passed
on to the default notification handler, which in this case is CWnd::OnToolTip-
Text. The handler retrieves the ID of the tool and any tooltip text associated
with it. After the text has been retrieved, the tooltip window will be displayed.
If the tool has no tooltip text, the window opens, but it is invisible.

To implement tooltips for tools inside windows that are not derived
from CFrameWnd, you must do two things: determine when the tooltip should
be displayed and provide text for the tooltip. If you implement tooltips using
the CToolTipCtrl class, all you have to do is register the tools and provide the
text for them.

Another feature of MFC that makes adding tooltips a little bit easier is
the ability to manage tooltips for multiple controls using just one CToolTipCtrl-
derived object. I demonstrate this feature in this task by adding three tools to
the CToolTipCtrl object.
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Step 1: Modifying the Modal Dialog Box

To implement tooltips for dialog box controls, you have to modify the dialog
box class by doing three things:

B Adding member variables for the dialog box tools and the common
tooltip control

B Adding a destructor if one does not already exist
# Overriding the OnlnitDialog and PostNcDestroy functions

Adding Member Variables for Each Tool in the Dialog Box
To add tools to the tooltip common control, you must add one member vari-
able to the dialog box class for each dialog box control. You then use the
member variables when initializing the common tooltip control. A quick way
to add member variables to your dialog box is to use the Resource editor and
ClassWizard.

Repeat the following procedure for each dialog box control that will have
a tooltip.

1. Open the dialog box resource in the Resource editor.

2. Double-click any control to which you want to add a tooltip while
holding down the Ctrl key. This invokes ClassWizard and automati-
cally opens the Member Variables page for your dialog box class.

3. Enter a name for the member variable, and select Control from the
Category drop-down list box.

4. Click OK to close the dialog box.
5. Click OK to close ClassWizard, which saves your changes.

NOTE: If you want to provide tooltips for a static control (or
controls), you must set the Notify style for the static control. This
style allows the control to send notification messages to its parent
(the dialog box), alerting the dialog box to display the tooltip for
the static control.

In your dialog box class, declare a member variable pointer of type
CToolTipCtrl, named m_pToolTip. In your dialog box constructor, add the fol-
lowing line:

m_pToolTip = NULL;
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This initializes the pointer of the common tooltip control to NULL. You
will use this value in the destructor to determine whether the pointer needs
to be freed.

Adding a Destructor

Because memory for the m_pToolTip pointer was allocated in the constructor
of the dialog box class, you will need a destructor to free that memory. Create
one now, and add the following code, which frees up the memory you allocat-
ed for the common tooltip control:

if (m_pToolTip != NULL)
delete m_pToolTip;

Overriding the OnlnitDialog and PostNcDestroy Functions

The last modification to the dialog box class is to override the OnlnitDialog
and PostNcDestroy functions. You can use the Message Maps tab of ClassWizard
to add these overrides.

Step 2: Modifying the OnlinitDialog and PostNcDestroy Functions

Now that you have overrides of OnInitDialog and PostNCDestroy, you will have
to add code to create and initialize the tooltip control. In the OnlInitDialog
function, create and initialize the common tooltip control. After all of the
dialog box tools have been added, activate the common tooltip control and
exit the function. Add the following code to your dialog box’s OnlnitDialog
function after the call to the base class and before the return statement:

if (Im_pToolTip)
{
int rt;
m_pToolTip = new CToolTipCtrl;
rt = m_pToolTip->Create(this);
ASSERT(rt != 0);
((CD1gTipsApp*)AfxGetApp())->m_gpToolTip = m_pToolTip;

CRect rc(11,17,29,37);

MapDialogRect(rc);

rt = m_pToolTip->AddTool(this, "Default MFC icon", rc,
IDC_MFCICON);

ASSERT(rt 1= 0);

rt = m_pToolTip->AddTool(this, "About Box");
ASSERT(rt != 0);

(continued)
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rt = m_pToolTip->AddTool(&m_btnOK, "OK Button");
ASSERT(rt != 0);

m_pToolTip->Activate(TRUE);
}
((CD1gTipsApp*)AfxGetApp())->m_hwndDialog = m_hWnd;

In the first section of code, I create the common tooltip control and assign
the result to the m_gpToolTip pointer, a data member of the application class.
In the next section, I initialize a CRect object with the client coordinates of
the static control. I then use this CRect object to add the dialog box icon to
the common tooltip control, m_pToolTipCtrl. In the next section, I add the di-
alog box and the OK button to the list of tools. Finally, I activate the common
tooltip control and assign the HWND of the dialog box to a data member
(m_hwndDialog) of the application class.

In the PostNcDestroy function (called after the dialog box object has been
destroyed), set the m_hwndDialogand m_gpToolTip data members of the appli-
cation class to NULL. Add the following code to your dialog’s PostNcDestroy
function after the call to the base class:

((CD1gTipsApp*)AfxGetApp())->m_hwndDialog = NULL;
((CD1gTipsApp*)AfxGetApp())->m_gpToolTip = NULL;

The NULL value indicates to the application object that the modal dialog box
has been dismissed.

Step 3: Modifying the Application Class
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Because you are using a modal dialog box, you have to check for mouse mes-
sages in the application class. To do this, declare two data members in your
application class: a pointer to the common tooltip control (m_gpToolTip) and
the handle to the dialog box object (m_hwndDialog). The code below is taken
from the sample project’s application class. These data members give you ac-
cess to the dialog box and to the common tooltip control of the dialog box.
Be sure you set both of these data members to NULL in the constructor of
the application class.

HWND m_hwndDialog;
CToolTipCtri* m_gpToolTip;

In addition to declaring the data members, you have to override the Pro-
cessMessageFilter function in the application class, which relays all messages
sent to the dialog box to the common tooltip control. Override this function
now. After you have done this, add the following code to the function body:
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if (m_hwndDialog != NULL)
if (1pMsg->hwnd == m_hwndDialog ||
::IsChild(m_hwndDialog, 1pMsg->hwnd))

if (m_gpToolTip != NULL)
m_gpToolTip->RelayEvent(1pMsg);
}

return CWinApp::ProcessMessageFilter(code, TpMsg);

In the first section of the code, I check to see whether the dialog box has
been created. If the check returns TRUE, I compare the handle of the mes-
sage to the handle of the dialog; if there is a match, I pass on the message with
a call to RelayEvent to the common tooltip control. If this check fails, I check
whether the handle of the message matches the handle of any children of the
dialog box (that is, dialog box controls). If there is a match, I pass on the mes-
sage with a call to RelayEvent to the common tooltip control. If there is no
match, I return the result of a call to the ProcessMessageFilter of the base class.

After you have completed these modifications, rebuild the project. You
should now have tooltips for all tools, including the dialog box itself, in your
dialog box.

Additional Information

For more information on providing tooltips for dialog box controls, see “Pro-
viding Tooltips for Dialog Controls” in Chapter 5. You might also want to
read the related Knowledge Base article “How to Add Tooltips to OLE Con-
trols™ Q141871.

Animating a Bitmap in the Status Bar

The purpose of this task is to animate a 16-color bitmap in the status bar of an
MFC application. This bitmap will be displayed in a new pane immediately
preceding the three default panes (the Caps Lock, Num Lock, and Scroll Lock
panes) of the MFC application. Animation is accomplished by loading a
slightly different bitmap (from a series of four bitmaps) in the same status bar
pane every quarter second using a system timer. The task consists of six steps:

1. Adding a CStatusBar-derived class to your project
2. Modifying the status bar class

3. Implementing the Drawltem member function of the status bar class
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4. Modifying the CMainFrame class
5. Creating a new pane for the bitmap
6. Implementing a WM_TIMER message handler

To complete this task, you will need the following:

# An SDI or MDI MFC application with a status bar

B Several 16-color bitmaps to display in a status bar pane

Because this task animates the bitmaps by displaying them in a fixed se-
quence, the animation effect is best achieved by slightly modifying each bit-
map in the sequence. The sample project, ANIMBAR, uses a sequence of four
bitmaps that represents a spinning CD-ROM.

NOTE: This discussion assumes you are using a version of MFC
later than 4.0. If you are using an earlier version of MFC, see the side-
bar information “MFC Versions 4.x and Later.”

Step 1: Adding a CStatusBar-Derived Class to Your Project
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In a default MFC application created by AppWizard, a status bar is provided
with basic features:

B An area for text messages
i State indicators for the Caps Lock, Num Lock, and Scroll Lock keys
# The ability to toggle the visibility of the toolbar

In most applications, this functionality is sufficient, but there are always cases
in which it is just not good enough. Animating a bitmap in a status bar pane
happens to be one of these cases. Because we are using a class library, we can
implement the functionality needed by deriving our own class from CStatusBar.
In this step, you will add a new status bar class and implement the bitmap fea-
ture in the later steps.

Add a class derived from CStatusBar to your project, using your favorite
method. The status bar class in the sample project is named CMyStatusBar.
While you are adding stuff to your project, add the bitmaps (16-color only)
you will be animating. Because the width and the height of the status bar pane
are fixed values, the dimensions of the bitmap must be 26 pixels wide by 13 pix-
els high. The ANIMBAR project uses a four-element array of CBitmap objects
(IDB_LBMAPO-IDB_BMAP3) that represents a spinning CD-ROM.
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Step 2: Modifying the Status Bar Class

Now that you have a CStatusBar-derived class, you can begin to implement the
bitmap feature. In this step, you will add two data members and modify the
constructor. To modify the status bar class, follow these steps:

1. Add the lines of code shown below to the definition of your new sta-
tus bar class:

// Attributes

private:
CBitmap m_bmpArray[4];
int m_curBmap;

2. Add the following lines of code to the constructor of your new status
bar class:

VERIFY(m_bmpArray[@].LoadBitmap(IDB_BMAPQ));
VERIFY(m_bmpArray[1l].LoadBitmap(IDB_BMAP1));
VERIFY(m_bmpArray[2].LoadBitmap(IDB_BMAP2));
VERIFY(m_bmpArray[3].LoadBitmap(IDB_BMAP3));

m_curBmap = 0;

In this step, the bitmap array m_bmpArray was set up to store the bitmaps used
in the animation sequence. In step 3, you will modify the constructor of the sta-
tus bar to load the four bitmaps that will be displayed.

Step 3: Implementing the Drawlitem
Member Function of the Status Bar Class

In this step, you will complete the modifications to the status bar class and
add the code used to render the bitmap in the status bar pane. Once again,
you can override a member function and place the rendering code there.
This member function, CStatusBar::Drawltem, is called by the framework when-
ever the status bar items need to be redrawn. You’ll have to customize the be-
havior of this function to properly animate your bitmap in the second status
bar pane. However, because you have to control only the painting of the bit-
map pane, you pass off the rest of the panes to the default function.

ClassWizard does not allow you to override the default function, so you
add the function by hand. First add the following line to the public section of
your status bar class declaration, which is located in the header file:

virtual void DrawItem(LPDRAWITEMSTRUCT 1pDrawItemStruct)

Now add the function body shown on the followmg page to the 1mp1ementa—
tion file of your status bar class.
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void CMyStatusBar::Drawltem(LPDRAWITEMSTRUCT TpDrawlItemStruct)
{
switch(1pDrawltemStruct->itemID)
{
case 1:
// Attach to a CDC object
CDC dc;
dc.Attach(1pDrawItemStruct->hDC);

// Get the pane rectangle, and calculate

// text coordinates

CRect rect(&1pDrawltemStruct->rcltem);

// Select current bitmap into a compatible CDC
CDC srcDC;

srcDC.CreateCompatibleDC(NULL);

CBitmap* pOl1dBitmap;

switch(m_curBmap)

{

case 0:
pO1dBitmap = srcDC.SelectObject(&m_bmpArray[0]1);
break;

case 1:
pO1dBitmap
break;

case 2:
pO1dBitmap
break;

case 3:
pO1dBitmap
break;

srcDC.SelectObject (&m_bmpArray[1]);

srcDC.SelectObject(&m_bmpArray[2]1);

srcDC.SelectObject(&m_bmpArray[31);
}
dc.BitBlt(rect.left, rect.top, rect.Width(), rect.Height(),
&srcDC, @, @, SRCCOPY); // BitB1t to pane rect
srcDC.SelectObject(p0O1dBitmap);
// Detach from the CDC object; otherwise, the hDC will be

- // destroyed when the CDC object goes out of scope
dc.Detach();

return;
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If you have done any bitmap painting in the past, most of the preceding
code will be pretty familiar to you. Basically, the logic of the function first deter-
mines the ID of the pane being notified (of the need to render itself). Because
the bitmap pane is the second in a zero-based array, I check for an ID of 1. If
the ID is a match, I grab the device context for the status bar and calculate the
coordinates of the bitmap pane. I then create a compatible device context
and, depending on where we are in the animation sequence (m_curBmap),
load the proper bitmap. The bitmap is then copied to the compatible device
context. Finally I detach from the status bar device context and return from
the Drawltem function. However, if the ID is not a match, I simply fall through
the switch statement and pass the notification on to the default Drawltem
function.

At this point, you have completed the implementation of the custom-
ized status bar. In the remaining steps, you will modify the frame window class
so that it will use your custom status bar and create a new pane for the bitmap.

Step 4: Modifying the CMainFrame Class

To see the new status bar, you have to add the include file for the new status
bar class and then make two modifications that affect the behavior of the
main frame window object. First add the following line to the top of your
CMainFrame header file so that you can use the CMyStatusBar class.

#include "MyStatusBar.h"

Now move on to the modifications for the CMainFrame class. The first
modification involves the type of status bar class used by the main frame win-
dow. Currently the main frame window uses a default status bar class of type
CStatusBar. This default status bar class has to be changed so that the new, cus-
tomized status bar class is used instead. This is easily done by changing the
following line

CStatusBar m_wndStatusBar;
in the header file of the main frame window class to
CMyStatusBar m_wndStatusBar;

The second modification involves the OnCreate function of CMainFrame.
After the status bar has been created, it’s necessary to modify the attributes of
the pane containing the bitmap so that painting notifications are automati-
cally sent to the bitmap pane when this pane needs to be repainted. In addi-
tion, you have to set the system timer for a 250-millisecond interval. This will
drive the animation sequence by displaying the next bitmap in the sequence
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in the new bitmap pane. (The actual handler for the WM_TIMER messages
will be added in step 6.) Add the following code right after the call to the Cre-
ate function of the status bar:

UINT nID, nStyle;

int cxWidth;

m_wndStatusBar.GetPaneInfo(1l, nID, nStyle, cxWidth);
m_wndStatusBar.SetPaneInfo(l, nID, nStyle | SBT_OWNERDRAW, 23);

if (!SetTimer(100, 250, NULL))

AfxMessageBox("No timer available™);
In the first section of code, I retrieve the attributes of the bitmap pane, set the
owner-draw attribute of the bitmap pane, and set the pane width to 26 pixels.
I then attempt to start a system timer. However, because system timers are a
limited resource, it’s possible that no timers will be available. Therefore, if the
attempt fails, I display a message box stating the failure.

Step 5: Creating a New Pane for the Bitmap
In step 5, you create a new pane for the bitmap animation. If one is not cre-
ated, the animation will be rendered in the Caps Lock indicator pane. To cre-
ate a new pane, follow these steps:

1. Add a new resource string named ID_INDICATOR_BMAP to the
string table of your project with the caption BMAP.

2. In the implementation file of the CMainFrame class, modify the indi-
cators array declaration to match the following:

static UINT indicators[] =

{
ID_SEPARATOR, // Status 1ine indicator
ID_INDICATOR_BMAP, // Add this Tine
ID_INDICATOR_CAPS,
ID_INDICATOR_NUM,
ID_INDICATOR_SCRL,

};

By adding an entry (ID_INDICATOR_BMAP) to the array of “indicator” panes,
you have created a new pane that is located immediately after the separator
of the first pane. :

Step 6: Implementing a WM_TIMER Message Handler

The last step in this task involves implementing a WM_TIMER message han-
dler. In this handler, the current bitmap counter m_curBmap will be advanced
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and the bitmap pane invalidated, which causes a new bitmap to be drawn that
is slightly different from the previous one. Because a WM_TIMER message is
received every quarter second, four bitmaps will be drawn, resulting in a spin-
ning CD.

First add a handler for WM_TIMER messages to your CMainFrame class
using your favorite method. Now replace the CMainFrame::OnTimer function
body with the following code:

CRect rect;

if (m_wndStatusBar.m_curBmap == 3)
m_wndStatusBar.m_curBmap = 0;

else )
m_wndStatusBar.m_curBmap++;

m_wndStatusBar.GetItemRect(1l, &rect); // Get pane rect
m_wndStatusBar.InvalidateRect(rect, FALSE);

CFrameWnd: :OnTimer(nIDEvent);

In the first section of code, I check the value of m_wndStatusBarm_curBmap
and, depending on the value, reset it to 0 or increment it by 1. I then retrieve the
region occupied by the bitmap pane and pass it on to the CStatusBar::Invali-
dateRect function, which causes a repaint of my bitmap pane. Finally I pass on
the timer event to the parent class and exit the function.

NOTE: The call to CFrameWnd::OnTimer assumes that you are
working with an SDI application. If the application is an MDI appli-
cation, you should make a call instead to CMDIFrameWnd::OnTimer.

You have now completed all of the steps required for displaying an ani-
mated bitmap in the status bar. Rebuild your project, and you will see a new
pane with an animated bitmap in your application.

Additional Information
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The procedure above can be modified to display only a 16-color bitmap in the
status bar of an MFC application. The necessary modifications are as follows:

B In step 2, use a CBitmap member function instead of a CBitmap array,
and load only the single bitmap in the status bar’s constructor. In ad-
dition, the m_curBmap member variable is not required.
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W The Drawltem function in step 3 does not need a switch statement to
determine the proper bitmap to load. Just load the single bitmap
stored in the CBitmap member variable of your status bar.

W The Create function in step 4 should not create a timer.

B Step 6 should be dropped because the timer resource was removed
in step 4.
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CHAPTER THRESE

Document Templates

The document-view model is one of the more essential and at the same time
most misunderstood features of the MFC library. After providing MFC tele-
phone support for an extended period of time, I came to realize that, in most
cases, people who do not like the document-view model do not understand
two key points:

# The document-view model is only a model and cannot be applied to
all programming questions. Therefore, in some cases, this model will
not support the purpose of the developer’s application.

#® The document template is used to create the three necessary ele-
ments of a document type: the frame window, the document, and the
view. All of these elements are created automatically by the document
template and can be customized to some degree to fit your own
needs. If you don’t fully understand the mechanics of the document
template, you will be forced to use the default template style.

In this chapter, I explain the basics of document templates—what they
are, how they are used in an MFC application framework, and so forth. In addi-
tion, I explain each stage of the document creation process and describe what
areas can be customized and why you might want to customize them. This chap-
ter is not a detailed overview of document templates but an intermediate-level
discussion of document template mechanics. I assume that you understand
the general process of document creation. (For a complete, detailed overview
of the document creation process, see “Document Templates” under “Using the
Classes to Write Applications for Windows” in “Programming with MFC” in the
online documentation.)

In the context of this discussion, access point is defined as any member
function that can be overridden from a local class or as any function defined
by a local class that is called automatically (by the framework) during normal
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program execution—specifically, a function that either is overridable or is called
during the creation of a document and view with a framing window. For the
purpose of this discussion, I use the member functions of a class as access
points to customize or to poll the current process, such as document creation.

The chapter is broken into three general areas of discussion and three
specific tasks related to document templates. The areas of general discussion
are the following: '

E Overview of document templates Highlights of the process for us-
ing a document template to create or open a document.

B The default mechanics of document templates A detailed descrip-
tion of the default mechanics of document templates in SDI and MDI
applications. In addition, I discuss certain functions generated by
AppWizard that allow safe customization of the document creation
process..

& Customizing the document template An analysis of MFC functions
that can be used to safely customize the default mechanics of the
document template process. '

Overview of Document Templates
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Every MFC SDI application created by AppWizard has at least one document
template. This template (referred to as the document type) creates and de-
fines the relationships between the document, frame window, and view ele-
ments. When a new document is created or an existing document is opened,
this template is used to create the elements in this order: document, frame
window, and view.

For MFC MDI applications, an extra step is required to create the top-
level frame window of the application before a document can be created. Af-
ter this step is completed, the process used for an SDI application is used to
create the requested document.

The document template, as its name suggests, maps the document,
frame window, and view elements to the actual MFC classes in an application.
When a user requests an application to supply a document (either existing or
new), this request is passed to the appropriate document template. The docu-
ment template, in turn, “requests” that each element defined by the template
create itself in a specific sequence. These requests are the main purpose of
the document template. All other details, such as frame window titles and the
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size of the view, are determined by the respective elements of the document
type. Once these elements have been created, the frame window displays a view
with the document’s data.

The Default Mechanics of Document Templates

By default, an application created by AppWizard contains at least one docu-
ment template. Because this template is responsible for creating the classes
of a specific document type, the constructor requires three class names and a
resource ID, as shown in the following example:

CSingleDocTemplate* pDocTemplate;
pDocTemplate = new CSingleDocTemplate(
IDR_MAINFRAME,
RUNTIME_CLASS(CSdiDoc),
RUNTIME_CLASS(CMainFrame), // Main SDI frame window
RUNTIME_CLASS(CSdiView));
AddDocTemplate(pDocTemplate);

In this example, CSdiDocis the document class, CMainFrameis the main frame
window of the application (because the application type is SDI), and CSd:iView
is the view element. The shared resource for this document type is IDR-
-MAINFRAME. This shared resource usually contains a menu and icons,
which are used by all three document elements. When a template is created,
itis registered with the application by a call to AddDocTemplate; this is the only
way the application knows what document types it supports.

In addition to supplying a registered document template, the SDI appli-
cation framework provides several access points (in the form of member
functions) in the document-view creation process. The default support can
be examined with respect to the creation of three main document type ele-
ments: the document element, the frame window element, and the view ele-
ment. Because member functions for frame window and view classes are
similar, I will discuss them at the same time.

One final note—in addition to the default access points of an SDI appli-
cation, MDI applications have access to the creation process of the main
frame window. The access points in this step (which occurs before the docu-
ment element is created) are similar to the access points in the frame window
and view creation steps.
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Creating the Document Element
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When a document is created or opened, the first task of its template is to cre-
ate the document element. This is accomplished at the first access point, the
document element’s constructor. In an SDI application, the constructor is
called only once because the framework “recycles” the document element
whenever a new file is created or an existing document is opened. In an MDI
application, the constructor is called every time a document is created or
opened because the MDI architecture creates a separate child window for
each document that is open in the application.

The second access point, CDocument::OnNewDocument, notifies the appli-
cation each time a new document is created. You can use this function to ini-
tialize data that is common to all documents or to perform other actions,
such as cleanup, before the document is created. For more information, see
CDocument::OnNewDocument in the next task, “Customizing the Document
Template” on page 80.

Figure 3-1 is the first part of a timeline that shows the functions that are
called and the other events that occur when a document is created. The func-
tions shown in bold are referred to as access points and are added automati-
cally to the applications created by AppWizard.
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Figure 3-1.
The basic process of creating a document in an MFC application.




THREE: Document Templates

Creating the Frame Window and View Elements

After the document is created, the frame window, which contains the view ele-
ment, is created. As in creation of the document element, the constructor is
the first access point called by the framework. In most cases, this constructor
does nothing beyond initializing its member variables. Figure 3-2 illustrates
the second stage of the document creation timeline, showing the functions
called and the other events that occur while the frame window and view are
being created. The events in bold (the default access points) are created by
AppWizard.
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Figure 3-2.
The basic process for creating a frame window and view in an MFC application.

@

The next access point, the PreCreateWindow function, is more useful be-
cause you can modify the characteristics of the window using the CREATE-
STRUCT structure that is attached to the frame window or view of the
function. The CREATESTRUCT ‘structure determines the characteristics of
this object and also, among other things, the class name, styles, initial size, and
menu used by the window. MFC automatically calls the PreCreateWindow func-
tion prior to creating the window (hence, the name of the function). As a re-
sult, this function is a good place to modify the characteristics of your window
object because you do not call the Create function directly if you are using a
document template.

The usual modification of window characteristics calls the base class im-
plementation, properly initializing the contents. You then modify the struc-
ture values to achieve a desired effect, such as controlling the size of the
frame window or registering a custom window class. The modified structure is
used by the framework to create a frame window (or view) with the desired
characteristics.
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Customizing the Document Template

As I mentioned earlier, AppWizard creates several access points for the crea-
tion process of document, frame window, and view elements. In most cases,
these are adequate for the typical document. In those cases in which a more
flexible document type is needed, MFC fortunately provides additional access
points where you can “plug in” your own code.

In this discussion, customizations are grouped according to the class to
which they belong and the order in which they are used in the creation process.
The following sections cover how to customize these elements using class library
functions. A handful of functions can be used in several areas and are discussed
under “Additional Functions” on page 87.

Application-Related Functions
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Application-related functions include the following:

B CWinApp::OnFileNew
B CWinApp::OpenDocumentFile

CWinApp::OnFileNew

The first access point you can customize for new documents is the
ID_FILE_NEW command handler. The default handler calls CWinApp::On-
FileNew, which in turn calls CWinApp::OpenDocumentFile. If there is only one
registered template, CWinApp::OnFileNew tells the document template to cre-
ate a new document type. If there is more than one template, the application
displays a dialog box that lists the known templates. The user must choose
the proper document type, which then is created by the respective document
template.

If you want to customize this process (perhaps hiding the selection pro-
cess from the user, for example), add a command handler for ID_FILE_NEW
using ClassWizard. This causes the ID_FILE_NEW command to be sent ini-
tially to your application’s OnFileNew handler. In the OnFileNew handler, you
might add some code that finds the proper template (determined by you)
and creates a document-view pair. You also can create handler functions in
your application’s class that handle requests individually for a certain docu-
ment type. (For more information on this topic, see “Choosing a Document
Template Without the New Document Dialog Box” later in this chapter.) An-
other method for customizing the creation of new documents is described in
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the Microsoft Knowledge Base article “How to Create New Documents Without
CWinApp::OnFileNew”: Q113257.

NOTE: In addition to overriding OnFileNew, you also can over-
ride OnFileOpen to customize the opening of existing documents.

CWinApp::OpenDocumentFile

If you know the filename for the document you are opening, call CWinApp:.-
OpenDocumentFile (passing the filename) to create a document-view pair. This
function is commonly used in the InitInstance function to open a file or to by-
pass the New Document Type dialog box automatically. The first parameter of
the command line, if the command line is not empty, can be passed via a call
to OpenDocumentFile. If the application has only one template, a document-view
pair is created using that template. If multiple document templates exist, the
function tries to match the filename’s extension to a template in the applica-
tion’s template list. If the function finds a match, a document, a frame wmdow
and a view object are created.

Document Template—Related Functions

The primary purpose of document templates is to provide a plan for creating
a specific document type. This is a one-to-one relationship: one document
template produces one type of document. However, in order for an applica-
tion to access document templates, it must be registered with a call to AddDoc-
Template, usually from the application’s InitInstance function. Any templates
that are not registered with the application must be managed by the developer.

If you want to customize any part of the document creation process, you
might quickly end up handling document templates and perhaps various
parts of the creation process yourself. In these cases, you have access to the
template list from any part of your application just by grabbing the application
object and making a few calls to the GetFirstDocTemplatePosition function and the
GetNextDocTemplate function. The following sample code demonstrates a com-
mon way to gain access to the list:

CWinApp* pApp = AfxGetApp();
POSITION curTemplatePos = GetFirstDocTemplatePosition();

while (curTemplatePos != NULL)
{

(continued)
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CDocTemplate* curTemplate =
pApp->GetNextDocTemplate(curTemplatePos);
CString str;
curTemplate->GetDocString(str, CDocTemplate::docName);
if (str == "Bounce")
{
curTemplate->0OpenDocumentFile(NULL);
return;

The following functions can be used to manage or to customize various
parts of the document-view creation:

B CDocTemplate::OpenDocumentFile
Use this function when you need to create a document-view pair
from a specific template. This function is also called by CWinApp::-
OpenDocumentFile.

® CDocTemplate::CreateNewFrame

Use this function to create a new frame window that contains a
view based on the document class managed by the document tem-
plate. In addition to creating a new frame window, you can base the
new window on an existing document or frame window by passing an
existing frame window object via this function. The result of this call
is similar to the result of choosing New from the Window menu of the
application. (For more information on working with CreateNewFrame,
see the Knowledge Base article “Create Additional Views with Create-
NewFrame () Function” Q100993.)

8 CDocTemplate:: CreateNewDocument
Use this function to create a new document. The frame window
and the view must be created in a separate step.

B CDocTemplate::InitialUpdateFrame
After you have created a new frame using CreateNewFrame, you

should call InitialUpdateFrame to send WM_INITIALUPDATE mes-
sages to all children within the newly created frame. This allows all
children to perform any one-time initialization or actions needed be-
fore becoming visible. If there are no active views, the primary view of
the frame window becomes the active view. This member function is
defined in both the CDocTemplate and CFrameWnd classes. The Knowl-
edge Base article “Create Additional Views with CreateNewFrame ()
Function” Q100993 describes how to create additional views using
CreateNewFrame and InitialUpdateFrame.
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Document-Related Functions

Document-related functions include the following:

B CDocument::OnNewDocument
B CDocument::DeleteContents

B CDocument::SetModifiedFlag, CDocument::IsModified, and CDocu-
ment::SaveModified

CDocument::OnNewDocument

As mentioned under “The Default Mechanics of Document Templates,” CDocu-
ment::OnNewDocument is called when a new document is created. This func-
tion is commonly used to initialize the document’s data members.

NOTE: Ifthe user chooses the File New command in an SDI ap-
plication, the framework uses the CDocument::OnNewDocument func-
tion to re-initialize the existing document element rather than create
a new one. Therefore, to ensure data member initialization, place
your initialization code in this function instead of in the document
constructor.

CDocument::DeleteContents

This little-known function provides a useful way to receive notifications that
the current document is about to be destroyed. Because the default imple-
mentation of DeleteContents does nothing, override it in your document’s class
to free up any memory allocated by the document, to save any modifications
to the document, or to execute other tasks that need to run before the docu-
ment closes. This function is very useful in SDI applications, in which the
document element is reused when a new document is opened or created.

CDocument::SetModifiedFlag,

CDocument::IsModified, and CDocument::SaveModified

Because the document is responsible for its own data, it should check for any

modifications and query whether the user wants to save the document when
© it has been modified; the CDocument class provides three functions and a mem-

ber variable for this purpose. The member variable, named m_bModified, con-

tains the modified flag; the member functions SetModifiedFlag and IsModified

set and check the value of the member variable.

SaveModified calls IsModified, which then checks to see whether the docu-
ment has been modified. If it has been modified, IsModified displays an MB-
_YESNOCANCEL message box and handles each possible return value. If the
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user clicks Cancel, SaveModified returns FALSE, letting the calling function
know to cancel the current operation.

For the user to be prompted to save the document in all possible situa-
tions, you must set the m_bModified flag (by calling SetModifiedFlag(TRUE))
when the user modifies the document. If this is done correctly, SaveModified is
called no matter how your application is closed. This allows you to cancel the
current operation. The list below shows the various ways in which SaveModified
can be called.

Action Called By

Exit is chosen from the CWinApp::OnAppExit
top-level File menu.

Close is chosen from the CDocument::OnFileClose
MDI child’s File menu.

Close is chosen from the CFrameWnd.::OnFileClose
MDI system menu.

Close is chosen from the CFrameWnd::OnFileClose

system menu.

Frame Window-Related Functions
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Frame window-related functions include the following:

& CFraméWnd::LoadFrame
B CFraméWnd::PreCreateWindow
B CFrameWnd::ActivateFrame

CFrameWnd::LoadFrame

This function, which calls CFrameWnd::Create, can be used either to create and
display a frame window that is based on a document template or to create a
frame with a document and view without using a document template. By de-
fault, the document/frame/view object is created by the document template
by filling a CCreateContext object and calling CFrameWnd::LoadFrame. To associ-
ate the frame window that is to be created with a document-view pair, pass a
CCreateContext structure (with the desired document and view types) as the
last argument. For example, the code sample on the next page initializes a
CCreateContext structure with the current active document, pDoc, and the
proper view, pView. Note that m_pNewViewClass is a pointer of type CRuntime-
Class and that it allows you to specify the type of view class you want to use.
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CCreateContext newContext;
newContext.m_pNewViewClass = pView;
newContext.m_pNewDocTemplate = NULL;
newContext.m_plLastView = NULL;
newContext.m_pCurrentFrame = NULL;
newContext.m_pCurrentDoc = pDoc;

“How to Create MFC Applications That Do Not Have a Menu Bar,” Knowl-
edge Base article Q131368, describes an advanced task using CFrameWnd::Load-
Frame. The task demonstrates the steps for creating an MDI application without
a menu bar. Although this method is not recommended in most cases, it is
sometimes beneficial when the developer does not need menu bars for child
windows.

CFrameWnd::PreCreateWindow
This member function, found in both CFrameWnd and CView, is useful when
you are customizing the appearance of your frame and view windows. Over-
riding this function allows you to tap into the creation process of the docu-
ment template window. Without this function, there would be no way to
customize the creation of the window by altering the values for the CREATE-
STRUCT structure, which is passed in as a parameter to PreCreateWindow. The
CREATESTRUCT structure is used by MFC as a template for building the ac-
tual window. In this structure, you have access to, among other attributes, the
menu resource, the initial display size, and the name of the class on which the
Microsoft Windows object is based. For a complete description of CREATE-
STRUCT, see the Microsoft Visual C++ version 5 online documentation.
Overriding CFrameWnd.::PreCreateWindow is usually done to customize
attributes that are separate from the client area, such as the system menu,
window title, and menu resources. Some of the more common modifications
that can be made to these attributes are listed below:

B Removing the application’s system menu either temporarily or per-
manently. For details, see the Knowledge Base article “How to Re-
move the System Menu from an Iconized Application”: Q129224.

E Changing window attributes, such as size and window styles.

# Creating an application without a menu bar. For details, see the
Knowledge Base article “How to Create MFC Applications That Do
Not Have a Menu Bar”: Q131368.

E Changing the frame window title of an MDI child window. For de-
tails, see the Knowledge Base article “How to Change an MFC-Based
MDI Child Window’s Frame Text”: Q99182.
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B Modifying frame windows that have a CFormView-derived view. For de-
tails, see the Knowledge Base article “Using CFormView in SDI and
MDI Applications”: Q98598.

CFrameWnd::ActivateFrame

Opverride this function to create an initially minimized or maximized docu-
ment in an MDI application. In your override, call the parent’s ActivateFrame
function, passing SW_.SHOWMINIMIZED or SW_SHOWMAXIMIZED as the
parameter.

View-Related Functions
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View-related functions include the following:

B CView::PreCreateWindow
B CView::SetActiveView
B CView::OnActiveFrame

CView::PreCreateWindow

Override CView::PreCreateWindow to customize the client area of the frame win-
dow. An example of customizing the client area is specifying a custom window
class that is used to create the actual window object. This function dynami-
cally creates a class name, with the attributes specified by you. These at-
tributes include the window styles used, the cursor resource used by the
window, and the background brush color. For more information on custom
classes, see the online documentation, the Knowledge Base article “How to
Change the Mouse Pointer for a Window in MFC”: Q131991, and the task
“Choosing a Document Template Without the New Document Dialog Box”
later in this chapter.

CView::SetActiveView

The CView::SetActiveView function is commonly used when dynamically switching
views from the current active view to a hidden or newly created view. For an
example of switching views dynamically, check out the task “Implementing
Switchable Views for a Single Document” later in this chapter. There is also a
Knowledge Base article, “Switching Views in a Single Document Interface
Program”™: Q99562, that demonstrates dynamically switching a view in an SDI
application and in an MDI application, respectively.

CView::OnActivateFrame
The CView::OnActivateFrame function, which is called whenever CFrameWnd. -
OnActivate is called, can be used as an indicator for the gain or loss of view
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activation. In an MDI application, the OnActivateFrame function is called after
the view receives a WM_INITIALUPDATE message.

Additional Functions

An additional relevant function and structure include the following:

B CWnd::SendMessageToDescendants

B CCreateContext structure

CWnd::SendMessageToDescendants

This function is often used to send notification messages to descendants of
the frame window. One useful application is sending WM_INITIALUPDATE
or WM_IDLEUPDATECMDUI to control bars or to other windows (such as
individual dialog box controls) created outside the normal document-view
creation process.

NOTE: Because the messages WM_INITIALUPDATE and WM-
_IDLEUPDATECMDUI are private MFC messages, only windows
handled by an MFC class will be able to react to them. Standard
controls are not affected.

Sending WM_INITIALUPDATE or WM_IDLEUPDATECMDUI mes-
sages gives the descendants a chance to do one-time initialization. This noti-
fication simulates the traditional process of document-view creation.

CCreateContext structure

The main purpose of this structure is to provide a “context” whenever a frame
window, a document, or a view element is created dynamically. The context
structure is used here, just as it is for a document template, to determine what
document, view, or frame window class should be created with the new ele-
ment. The context structure is used most often when you dynamically create
an additional view or frame element or switch views on a single document.
The following example (creating a new view in an MDI application) demon-
strates this use, with pNewView as the pointer to the view class that is being cre-
ated and pDoc as the current active document:

context.m_pNewViewClass = pNewView;
context.m_pCurrentDoc = pDoc;
context.m_pNewDocTemplate = NULL;
context.m_plLastView = NULL;
context.m_pCurrentFrame = pFrame;

In most cases, only one or two members of the context need initializa-
tion, depending on which element is being created. Because the example is
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creating a new view to display the current document and to be a child of the
frame window (accessed using pFrame), the document, view, and frame are
initialized. However, the other members can be used at any time for your own
needs. For examples of using CCreateContext, see the following Knowledge Base
articles:

B Switching Views in a Single Document Interface Program: Q99562

B Replacing a View in a CMDIChildWnd Window: Q102829. (Article in
its updated form was not available for inclusion in Part II of this book
at press time; see the online version.)

# How to Create MFC Applications That Do Not Have a Menu Bar:
Q131368

Conclusion

My purpose in this discussion of document templates has been to shed some
light on the process of creating and opening documents in your MFC appli-
cation. By understanding how and when the default document template is
used, you can make better decisions with respect to when the default behav-
ior is enough for the job and when it is more appropriate to customize it. In
addition, you now know about a large group of functions that can enable you
to customize a document template to fit your needs.

I'hope you see that the document template is just another type of frame-
work (similar to the MFC library itself) that has a large amount of default sup-
port and is easy to customize. Use the ideas in this discussion (and the functions
contained in it) to dismantle the mystery of the document creation process.
Make the template work for you, not against you.

To demonstrate some of the ways you can customize the document-view
architecture, I have included three tasks in this chapter:

# Choosing a document template without the new document dialog box

# Adding a second view to a document

# Implementing switchable views for a single document

Choosing a Document Template
Without the New Document Dialog Box

The purpose of this task is to provide a different interface for choosing new
documents either automatically from a template list or graphically with a
group of toolbar buttons. By default, in applications with more than one
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document template, a dialog box (referred to as the New Document dialog
box) is displayed whenever the user opens a new document. This dialog box
lists all of the available document templates for the application. After the
user chooses the template type, a new document is created. However, you
might prefer a more graphical interface to this list of templates, perhaps a de-
scriptive toolbar button for each template. Or maybe you need more control
over the process. For example, your application might have a document type
that, when created, requires an additional document type to be created. In-
stead of the user having to create the second document type, your application
can automatically create the additional document when the user chooses the
proper document type.

In this task, I implement-a command handling mechanism that searches
the list of available templates and then creates a new document from the
proper template. The task has five steps:

Adding a new type of document template
Modifying the application’s resources

Modifying the application’s InitInstance function

Installing the new command handlers

S A

Implementing the new command handlers

WARNING: Ifyouare modifying an SDI-type application, you
must create a new, empty document before the application displays
itself. For more information, see “Additional Information” at the
end of this task.

The project is an MDI application, and its name is NEWTMPL. The re-
quirements for this task are:

B A new document type consisting of a document, a frame window, a
view class, and associated resources (such as an icon and a menu)

B One or more command handlers for creating a new document

Step 1: Adding a New Type of Document Template

The default AppWizard project (either SDI or MDI) includes a fully function-
ing document template. This document template, which consists of frame
window, document, and view elements, is automatically created and added to
the application’s document template list. The template list exists in the appli-
cation object, and it contains all document types known by the application.
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New document templates are added with a call to AddDocTemplate; this usually
occurs in the InitInstance function of the application class.

In this step, you will add three new classes to provide a second docu-
ment template that creates a document of type NewType. In this task, I use
the following class names:

Document Template (NewType) Classes

Class Name Description

CNewFrame The new template’s frame window element—
derived from CMDIChildWnd

CNewDocument The new template’s document element—
derived from CDocument

CNewView The new template’s view element—derived
from CView

NOTE: It’snotnecessary to derive the second child frame win-
dow class from CMDIChildWnd; you can use the base class directly
by substituting CMDIChildWnd for CNewFrame in the document tem-
plate definition.

Create three new classes of the types specified above using the New
Class command of ClassWizard. If you already have three classes of these
types, copy the header and implementation files to the directory of the
project to be modified and add them to the project using the Files Into
Project command on the Insert menu. These classes make up the majority of
the NewType document template. In addition to these classes, you will need
several resources, such as a menu, icons, and a string table entry.

Step 2: Modifying the Application’s Resources

90

In addition to classes, each document template usually contains a set of re-
sources that share a common resource ID. For instance, in the MDI applica-
tion framework created by AppWizard, the resource ID is the name of the
project with the suffix TYPE. In most cases, the resources consist of a menu,
an icon for the child object, and a string that describes the various elements
of the document template.

For this task, you can use a set of predefined resources, with the ID
IDR_DEFAULTYPE. These predefined resources can be copied from the DE-
FAULT.RC file, located in the \PROJECTS\DEFAULT directory on the com-
panion disc. The resources are made up of an icon, a menu that is based on
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the default menu generated by AppWizard, and the following string resource
(using IDR_DEFAULTYPE as the resource ID):

Defaul\n\nDefaul\n\n\nDefaul.Document\Defaul Document

If you want to create your own resources, you will need an icon, a menu
that has at a minimum all commands from the main menu resource, and a
string table entry similar to the default above. For more information on
strings of this type, see the Knowledge Base article “Format of the Document
Template String”: Q129095.

NOTE: Another option for new document template resources
is to copy existing resources in your application’s project and then
modify them. For example, if your project is an MDI application,
you should have resources for the original document template.
Copy the icon, menu, and string entry resources into similar types
using a new resource ID.

After you have the menu resource for the new template, add menu
items to create each document template. For example, if the project has a
Hello document and a Bounce document, add two menu items—New Hello
and New Bounce—to the File menu on all of the menu resources of the
project. Be sure you assign separate and distinct IDs for each item, such as
ID_FILE_NEWHELLO and ID_FILE_NEWBOUNCE; you will write com-
mand handlers for these later in the task. As you edit the menu resource,
there should be a New menu item or items with the ID ID_FILE_NEW that
you must remove. This is the default ID used by the framework to generate
new document types. Because you are bypassing this functionality, you don’t
need it anymore.

Step 3: Modifying the Application’s Initinstance Function

If your application was created by AppWizard, the InitInstance function per-
forms two chores that are important to this task: initializing the document tem- -
plate list and creating a new, empty, document type. In applications created
by AppWizard, the document template list is initialized with the default docu-
ment template in the first part of the application class’s InitInstance function.
The following code, taken from a default MDI application, adds the only docu-
ment template that is used by the application:

CMultiDocTemplate* pDocTemplate;
pDocTemplate = new CMultiDocTemplate(
IDR_MYPROJTYPE,

(continued)
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RUNTIME_CLASS(CProjDoc),

RUNTIME_CLASS(CNewFrame), // Custom MDI child frame

RUNTIME_CLASS(CProjView));
AddDocTemplate(pDocTemplate);

You can add your new document template right after the code above.
First add the include files for the three new classes to the top of the applica-
tion’s implementation file. For example, if you are using CNewFrame, CNewDoc,
and CNewView, the new code (in bold) will look like this:

#include "MainFrm.h"
#include "ChildFrm.h"
f#Finclude "NewTmplDoc.h"
f#include "NewTmplView.h"

jHinclude "NewFrame.h"
f#include "NewDoc.h"
f#include "NewView.h"

Add the following code right after the existing call to AddDocTemplate:

CMultiDocTemplate* pNewTemplate;
pNewTemplate = new CMultiDocTemplate(
IDR_NEWTYPE,
RUNTIME_CLASS(CNewDoc),
RUNTIME_CLASS(CNewFrame), // Custom MDI child frame
RUNTIME_CLASS(CNewView));
AddDocTemplate(pNewTemplate);

Notice that a new CMultiDocTemplate pointer (named pNewTemplate) is
initialized with the new resource ID and the three new classes you added ear-
lier. After the pointer is initialized, it is added to your application’s template
list with the call to AddDocTemplate.

NOTE: Ifyour application is an SDI-type application, use CSingle-
DocTemplate instead of CMultiDocTemplate.

The InitInstance function is also where the new empty document is cre-
ated. In the default application framework, the command line is parsed for any
commands. These commands are then executed by the framework. If no
commands are found, the ID_FILE_NEW command is handled, which usually
causes a new document to be displayed in the application window. First, a
cmdInfo object is initialized with any commands found:

// Parse command line for standard shell commands, DDE, file open
CCommandLineInfo cmdInfo;
ParseCommandLine(cmdInfo);

Then, in a call to ProcessShellCommand, the cmdInfo object is read. If no
commands are found, a call to OnFileNew is made:
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// Dispatch commands specified on the command line
if (!ProcessShellCommand(cmdInfo))
return FALSE;

In MDI applications, you can remove this code to prevent the creation
of an empty document. The application then comes up with an empty appli-
cation frame, and the user must then create a new document of his or her
choice using the new command handlers added in the next step. However, in
SDI applications, you must create a new window before exiting the Initln-
stance function. Therefore, you should leave in this code or implement an-
other method for creating a new window before exiting InitInstance.

Step 4: Installing the New Command Handlers

It’s time to add some new handlers for creating new document types using a
cool trick provided by the Resource editor. The following procedure for add-
ing new command handlers will install unique handlers for each document

type.

1. Open any menu resource that contains the File New commands for
your document type.

2. Expand the File menu (or other top-level menu that contains your
new document menu items).

3. While holding down the Ctrl key, double-click one of the new docu-
ment menu items. ClassWizard should then come up with the Mes-
sage Maps tab on top.

4. Add a command handler for the menu ID associated with the menu
item you chose in the main frame class—in this case, CMainFrame. Re-
peat this step to add handlers for all menu items that you added in
step 2. When all of the handlers have been added, save the project.

NOTE: The class associated with this menu will be chosen by
ClassWizard to handle the commands. If you want a different
class (perhaps the application class), choose it from the Class
Name list box and then add the handler. If the application class
is chosen, the template traversal code is slightly easier to read be-
cause you have eliminated the need for an application pointer.

Because you created a unique command handler for each document
type, you already know which document template should be used to create
the new document. All that is left to do is to search the document template
list for the proper template.
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There is also an alternative method for using only one command han-
dler for all New menu items; it parses the current message for the document
type. Details about this method can be found under “Additional Information”
at the end of this task.

Step 5: Implementing the New Command Handlers
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You now have a command handler for each new document type, but you still
have to find the right document template to create a functioning document-
view pair. Fortunately, the application class contains a complete list of tem-
plates. All you have to do is traverse this list, grab the right one, and call its
OpenDocument function.

Because the new document handlers are members of the main frame
window class, you will need to get a pointer to the application object and use
that pointer to access the document template list unless you chose a different
class. The following code uses a call to AfxGetApp to accomplish this:

CNewTemp1App* pApp;
pApp = (CNewTemplApp *)AfxGetApp();
POSITION curTemplatePos = pApp->GetFirstDocTemplatePosition();

Now use curTemplatePos to run through the available templates and grab
the proper one. The following code uses a call to GetDocString to match the
target string with the current template’s document name. If the match suc-
ceeds, you have the right one and can call OpenDocument. If there is no match,
continue traversing the list:

while(curTemplatePos != NULL)
{
CDocTemplate* curTemplate =
pApp->GetNextDocTemplate(curTemplatePos);
CString str;
curTemplate->GetDocString(str, CDocTemplate::fileNewName);
if (str == "NewType")
{
curTemplate->OpenDocumentFile(NULL);
return;

NOTE: In addition to CDocTemplate::docName, GetDocString can
return any one of the seven elements of the document type’s string
resource. However, in some cases, certain values will work only in
MDI-type applications. Check out GetDocString in the online docu-
mentation for details.
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The target string (in this case, NewType) is determined by the proper
document template resource string—in this case, the NewType document.
Each of the template strings should have a different set of string elements,
which allows you to distinguish between template types. I used CDocTemplate::-
docName because it works for both SDI- and MDI-type applications.

Now that you have completed one of the handlers, use similar code for
the others by changing the comparison to the new document type for which
you are searching. After you have built the project, the user will be able to
choose the document type he or she wants to create by executing the proper
menu command.

Additional Information

Here is some additional information to help you.

Alternative Methods for Handling New Document Commands

As I mentioned earlier, there are alternative methods for installing command
handlers for each document type. In one method, you have only one com-
mand handler, which contains all of the code for creating a new document.
In the future, if changes to the new document logic are needed, you need
modify only one function. Instead of installing a unique handler for each docu-
ment type, you map every New Document menu item to the same handler
(perhaps named OnMyNewDocument); then, before traversing the template list,
determine the command ID with the following line of code:

idVal= LOWORD(GetCurrentMessage()->wParam);

You can then set up a case statement that sets the target value to the
proper string value. The modified traverse function would look something
like this:

CNewTemplApp* pApp:;
pApp = (CNewTemplApp *)AfxGetApp();
POSITION curTemplatePos = pApp->GetFirstDocTemplatePosition();
// Grab the ID of the menu choice
CString targetVal;
idVal = LOWORD(GetCurrentMessage()->wParam);
switch(idval)
{
case ID_FILE_NEWTYPE:
targetVal = 'NewType';
case ID_FILE_OLDTYPE:
targetVal = '01dType";
}

(continued)
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// Traverse the 1ist to find the proper template
while (curTemplatePos != NULL)
{
CDocTemplate* curTemplate =
pApp->GetNextDocTemplate(curTemplatePos);
CString str;
curTemplate->GetDocString(str, CDocTemplate::docName);
if (str == targetVal)
{
curTemplate->0penDocumentFile(NULL);
return;

In the two methods discussed thus far, the document template variable
is created on the stack. Therefore, it exists only within the scope of the Initin-
stance function. Because of this and because the order of the document tem-
plates in the document template list cannot be assumed, you must search for
the proper template every time a new document is created. As it turns out,
this search is unnecessary if you keep a pointer to all document templates
used in the application. When placed in the application’s class, these point-
ers allow permanent access from anywhere in the application at any time. In-
stead of searching, you can simply call the OpenDocumentFile function of the
appropriate template using the stored pointer.

Modifying SDI-Type Applications

Before an SDI-type application is visible, the m_pMainWnd data member must
point to the main frame window of the application. This means that a new,
empty document must be created in order to create a valid frame window ob-
ject. Unfortunately, one result of this task is that the application appears with
no new document. In order for an SDI application to become visible, you
must create a new, empty document during startup. After the empty docu-
ment is created, the user can create new documents of his or her choice.

Additional Reading

Technical Note 22 in the Visual C++ online documentation provides an excel-
lent description of handling standard MFC commands. There is also men-
tion of other customizations for handling new document requests. The
Knowledge Base article “How to Create New Documents Without CWinApp::-
OnFileNew”: Q113257 discusses yet another method of bypassing the default
handling of OnFileNew.
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The Source Code Is Your Friend!

I found the procedure used in this task (document template traversal) by step-
ping through the source code of ProcessShellCommand. In addition, the reason
why OnFileNew is called is obvious if you continue to step through with a little
patience.

Adding a Second View to a Document

The purpose of this task is to implement two different view types for a single
document. The two views are shown simultaneously in a static splitter window
(Figure 3-3)—each pane displaying a different view of the document data.
The first view is a graphical representation derived from CView; the second is
a control view derived from CFormView. Each view is able to notify the docu-
ment when data is changed by the user, which “prompts” the document to up-
date all views automatically.

Figure 3-3.
Application with both panes visible.

This type of application is commonly referred to as a multiple view
interface (MVI) application. All MVI applications must use splitter windows
that come as one of two types—dynamic splitter windows, which must use the
same view class for each pane, or static splitter windows, which can use different
view classes for each pane. This task demonstrates the implementation of a
static splitter window, which is the more complex of the two types of windows.
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The task consists of two steps:

1. Adding a second view class

2. Modifying the main frame window class

The project name is SPLITR, and the requirement is a CView-derived
class, which is used as the second view.

NOTE: ]Justto keep you from getting confused: in the sample
project I have provided for this task, one of the data types for the
document is a custom class named CMyRect, which has its own
header and implementation files, MYRECT.H and MYRECT.CPP,
respectively. In addition, the second type of view class (CDigView) is
derived from CFormView and has its own header and implementa-
tion files, DLGVIEW.H and DLGVIEW.CPP, respectively. All refer-
ences to these classes are for the sample project only.

Step 1: Adding a Second View Class

Because the sample implementation uses a static splitter window, derive a sec-
ond view class from CView (the sample derives the second view class from
CFormView) and add it to your project. If you have an existing view class, you
can simply add the files to the project by choosing the Add To Project/Files
command from the Project menu. If you create the class with ClassWizard,
the files are added automatically, plus you get a basic class frame with which
to work. As I mentioned above, the second view class, CDigView, is derived
from CFormView. The form view contains a set of controls that allows the user
to select one of five MyRect objects displayed in the left pane and to manipu-
late its values.

Step 2: Modifying the Main Frame Window Class
Now that you have two view classes, you have to modify the main frame window

class, usually CMainFrame, to create a splitter window with two panes that dis-
play the different views. These are the modifications you will have to make:

B Adding a CSplitterWnd data member to the CMainFrame class. The
data member is used later to point to the new splitter window.

B Adding the header files for the document and new view classes to the
CMainFrameimplementation file. This allows us to use the document
and new view class types in the implementation code for the splitter
window.
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B Overriding the OnCreateClient function in the CMainFrame class (if it
is not already overidden), and adding code for creating the splitter
window and its panes. This function provides a handy place to create
the splitter window and its two panes.

To modify the main frame window, follow this procedure:

1. Add the splitter window data member by adding the following line to
the CMainFrame header file:

// Attributes
protected:
CSplitterWnd m_wndSplitter;

Declaring the data member “protected” is not required, but it does
strengthen the modularity of the class.

2. In the implementation file of CMainFrame, add the header files for
your application’s document class and the view classes.

NOTE: Including the header file of the document class (in
this case, SPLITRDOC.H) is optional. In most cases, however,
your second view interacts with the document, which requires
the document’s header file to resolve document references.

The example below shows the lines you would add to the imple-
mentation file of the main frame class to include the SPLITR project
header files for the document and two view classes:

f#include "splitrDoc.h"
f#include "splitrView.h"
#include "DigView.h"

3. To properly create the splitter window and panes, override the OnCre-
ateClient function using ClassWizard in the CMainFrame class. The re-
sult is shown below. The lines in bold were added by ClassWizard.

//{{AFX_VIRTUAL(CMainFrame)

public:

virtual BOOL OnCreateCl1ient(LPCREATESTRUCT 1pcs,
CCreateContext* pContext);

(continued)
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virtual BOOL PreCreateWindow(CREATESTRUCT& cs);

In the implementation file of MAINFRM.CPP, the body of the
OnCreateClient function looks like this:

BOOL CMainFrame::0OnCreateClient(LPCREATESTRUCT /*1pcs*/,
CCreateContext* pContext)
{

return CMainFrame::0OnCreateClient(1pcs, pContext);

4. Add code to the OnCreateClient function to create and initialize the
splitter panes. Because I am creating a static splitter window, I use
CSplitterWnd:: CreateStatic and CSplitterWnd::CreateView. The following
code added to the OnCreateClient function creates a splitter window
with one row and two columns. The left pane is created using CSplitr-
View (the initial project’s class) as the view class. The second pane is
created using CDlgView as the view class.

// Create a splitter with 1 row, 2 columns
if (I!m_wndSplitter.CreateStatic(this, 1, 2))
{
TRACEOQ("Failed to create static splitters\n");
return FALSE;
}
// Add the first splitter pane--the default view in column 0
if (!m_wndSplitter.CreateView(0, 0,
RUNTIME_CLASS(CSpTlitrView), CSize(590, 50), pContext))
{
TRACEQ("Failed to create first pane\n");
return FALSE;
}
// Add the second splitter pane--an input view in column 1
if (Im_wndSplitter.CreateView(0, 1,
RUNTIME_CLASS(CD1gView), CSize(@, @), pContext))
{
TRACE@Q("Failed to create second pane\n");
return FALSE;
}
// Activate the input view
SetActiveView((CView*)m_wndSplitter.GetPane(0,1));

return TRUE;
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After you add the new view class and implement CMainFrame::OnCreate-
Client, your application should have a splitter window with two panes. The
content of each pane depends on the OnDraw code in your view classes. If you
have nothing in the OnDraw functions, these panes will be blank.

Additional Information

The SPLITR project contains additional code that synchronizes the view and
document classes, specifically, code for the following functions:

B CSplitrView::OnlnitialUpdate()

B CDlgView::GetDocument()

B CDlgView::DoDataExchange(CDataExchange* pDX)
B CDIgView::OnlnitialUpdate()

B CDlgView::OnUpdate

B CDlgView::OnUpdateRect()

Another method for implementing multiple views on a single document
(described in detail in the next task) allows a user to switch views at any time.

Implementing Switchable
Views for a Single Document

The purpose of this task is to implement switchable views for the same docu-
ment in an existing SDI application. In the sample application, the default
view (shown in Figure 3-4 on the following page) is derived from CView and
the second view (shown in Figure 3-5 on the following page) is derived from
CFormView. The second view contains controls that allow the user to modify
the attributes of the document’s data. The document’s data consists of a group
of rectangles randomly generated and colored, which are drawn in the initial
view and can be modified in the second view. In the procedure presented here,
I use the AddView and RemoveView member functions of CDocument.

Initially, the document has one view—the existing view provided by the
application. The user can switch the views using either the toolbar or the
View menu options. The main frame window, CMainFrame, handles the re-
quest to switch views by creating a second view if necessary and then swap-
ping the view IDs, hiding the current view, and showing the second view. The
frame window keeps track of both views, including which of the views is the
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Figure 3-4.
Application with graphical view.

Figure 3-5.
Application with common controls view.
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current one. It also handles the destruction of the second view and restora-
tion of the initial view when the application ends or when a new document is
created. The task has five steps:

Adding the new view class

Modifying the frame window class

Implementing the OnViewSwitch function

Re-initializing the document

R

Adding resources for switching views
The name of the project is SWITCH, and these are the requirements:

B A CView-derived class, which will be used as the second view

# A function, for this task named OnViewSwitch, that switches the cur-
rent view with a hidden view

B A function, for this task named CleanUpViews, that resets the state of
the document when a new document is requested

B Graphical resources, such as buttons or a toolbar, to switch between
the views ‘

Step 1: Adding the New View Class

The first step is to add the view to which and from which you will be switch-
ing. You can create a new view class or use an existing view class. If you are go-
ing to use an existing CView-derived class, you should copy the header and
implementation files to the project directory and add them to the project.
There are probably references (for example, #include directives, obsolete
classes, and so on) that should be modified or removed; a quick way to track
these down is to rebuild the project and fix all of the errors that pop up.

If you created the new view class with ClassWizard, modify the view’s
header file by changing the access specifier for the constructor, the destruc-
tor, and the OnlnitialUpdate function from “protected” to “public.” This al-
lows the class to be created directly by other classes. You can rebuild the
project, but it isn’t required yet. Because the new view class will be interacting
with the existing document class, it’s a good idea to implement some type of
GetDocument function in your new view class. If you access the document from
the view class by name, add the document’s header file to either the header
or the implementation file of the view class.
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~TIP: Ifyour project was created by AppWizard, you already have
a working function, GetDocument. Make this a member function of
your new view class by copying over the Debug and Release ver-
sions of the function. Make sure you grab the inline function,
which is found in the header file of the view class, and the release
version, which is found near the diagnostic functions.

For the second view to display the document data correctly, some type of
synchronization with the document data is needed. Because the sample
project uses a form view as the second view, I override CFormView::Onlnitial-
Update and CFormView::OnUpdate for one-time initialization and synchroniza-
tion with the document data. Use this method if your second view is derived
from CFormView.

If your view is derived from CView, override the OnlnitialUpdate and
OnActivateView functions of your view’s class. In addition to activating the
view, OnActivateView is called when the view is being deactivated; therefore,
check for this possibility and update the data only when the view is activated.

Step 2: Modifying the Frame Window Class
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In a typical SDI application, switching between views is done easily in only two
classes—the application class and the main frame window class. Either class is
able to switch views, but if you choose the main frame window class, you save
yourself a bit of typing. The sample project switches the views from the
CMainFrame class, so I am assuming that you also are choosing CMainFrame.
After you have chosen the class, make these modifications:

B Add the header file of the new view class to the implementation file
of the chosen class.

@ Add data members that will store the existing views and track the cur-
rent view.

Because the switching function uses the new operator to create a second view,
include the header file for the second view class in the implementation file of
CMainFrame.

NOTE: Because I've used a form view in the sample project,
AFXPRIV.H was included by class CMainFrame. This allows the class
to send WM_INITIALUPDATE messages.

CMainFrame also needs a way to access both views easily. This is accom-
plished by adding two pointers (of type CView) to CMainFrame. These data
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members should be “public.” To make it easier to see which view is current,
add another variable named m_currentView of type int:

public:

// Attributes
CViews m_pViewl;
CView* m_pView2;
CView m_currentView;

In the CMainFrame constructor, initialize both view pointers to NULL
and m_currentView to 1. This indicates that the current view is the original
project view; the numeral 2 indicates that the current view is the new view.

CMainFrame::CMainFrame()

{
m_pViewl = NULL;
m_pView2 = NULL;
m_currentView = 1;
}
Now you can implement the handler function for switching views, On-
ViewSwitch.

Step 3: Implementing the OnViewSwitch Function

This is the key activity of the task. To switch views successfully, the OnViewSwitch
function must do the following:

E Create a second view if one is needed.

E Switch the IDs of both views.

i Display the alternate view and hide the current view.

® Modify the document’s list of views.

Because of the size of the OnViewSwitch function, I split the function
into four parts for the purpose of this discussion. I will list the parts in the or-
der in which they appear in the OnViewSwitch function and then discuss what

they do. You can either add the body of the entire function now or add each
part as it’s discussed.

1. Add the code on the following page to the beginning of the OnView-
Switch function.
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CView* pViewAdd;

CView* pViewRemove;

CDocument=* pDoc = GetActiveDocument();
BOOL bCreated = FALSE;

UINT nCmdID;

nCmdID = LOWORD(GetCurrentMessage()->wParam);

if ((nCmdID == ID_VIEW_VIEW1) && (m_currentView == 1))
return; :

if ((nCmdID == ID_VIEW_VIEW2) && (m_currentView == 2))
return;

In the first section of code, I retrieve a pointer to the document and
the command ID of the current message. I then use the command ID
to determine whether the current view is the one chosen by the user.
If so, the function returns, doing nothing. If the request is valid, the
switch is initiated.

2. Add the code below immediately after the code in section 1 above:

if (nCmdID == ID_VIEW_VIEW2)

{
if (m_pView2 == NULL)
{
m_pViewl = GetActiveView();
m_pView2 = new CMyView2;
m_pView2->Create(NULL, NULL, AFX_WS_DEFAULT_VIEW,
rectDefault, this, AFX_IDW_PANE_FIRST + 1, NULL);
bCreated = TRUE;
}
pViewAdd = m_pView2;
pViewRemove = m_pViewl;
m_currentView = 2;
}
else
{
pViewAdd = m_pViewl;
pViewRemove = m_pView2;
m_currentView = 1;
}

In this section of code, if the view to which you are switching is the
second view and the pointer (m_pView2) is NULL, the view is created
and bCreated is set to TRUE. When both views exist, the pointers are
set to their proper values.
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3. Add the code below immediately after the code in section 2:

int nSwitchChildID = pViewAdd->GetD1gCtr1ID();
pViewAdd->SetD1gCtr1ID(AFX_IDW_PANE_FIRST);
pViewRemove->SetD1gCtr1ID(nSwitchChildID);

// Show the newly active view, and hide the inactive view

pViewAdd->ShowWindow(SW_SHOW) ;
pViewRemove->ShowWindow(SW_HIDE) ;

In this section of code, I set the view ID of the newly active view to
AFX_IDW_PANE_FIRST so that CFrameWnd::RecalcLayout will allo-
cate to this “first pane” the portion of the frame window’s client area
not allocated to control bars. After the IDs have been switched, I show
the newly active view and hide the other view.

4. Add the code below immediately after the code in section 3 above:

pDoc->AddView(pViewAdd);
~ pDoc->RemoveView(pViewRemove);

SetActiveView(pViewAdd);
RecalclLayout();

5. Finally, I replace the old view in the active document’s list of views
with the new view. Then I notify the new view and readjust the layout.

NOTE: If you step through the Debug version of the OnView-
Switch function, you will see the following warning: “Creating a pane
with no CDocument.” This warning is generated when the call to
CMyView2::Create occurs before the call to initialize a document.
The view has no document until the call to CDocument::AddView is -
made later in the function. This warning does not indicate a mem-
ory leak, illegal accessing, or any other dangerous behavior.

Step 4: Re-Initializing the Document

The application framework behaves a little differently when a new document
is created in an MDI application than when it is created in an SDI applica-
tion. In an SDI application, only one document, view, and frame window can
be open at any one time. However, in the case of the application used in this
task (which uses splitter windows), the splitter window occupies the client
area of the main frame window. Each pane of the splitter has a different
CWnd-derived object. This allows an SDI application to have more than one
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CView-derived object. When a new document is requested in an SDI applica-
tion, the framework reuses the existing components. This means that the ex-
isting document, view, and frame objects are wiped clean and then used to set
up the new document-view pair.

Because the framework reuses the existing components in an SDI appli-
cation, you must be very careful to return the document, view, and frame win-
dow objects to their original state. If you were to build your modified project
right now (assuming you have a user interface for switching), you could dem-
onstrate this need for extra care quite easily. Just start the application, switch
to the second view (forcing a creation of the view), and then request a new
document. You then will get a large, nasty assertion error because the de-
tached view tried to access its document and came up with nothing. There-
fore, you need to check for a couple of things before letting the application
create a new document. If the second view was not created, everything is fine.
If the second view was created and is the current view, you should switch views
and then destroy the second view. If the second view was created and is cur-
rently detached, simply destroy the second view.

With SDI application architecture, there is really only one place to put
this code, and that is in the document’s override of OnNewDocument. It is the
only place that gets called every time a new document is created. To keep the
code neat and readable, the SWITCH project makes a call to CleanUpViews in
OnNewDocument that determines and executes the proper action. The Clean-
UpViews function is as follows:

void CSwitchDoc::CleanUpViews()
{
CMainFrame* pFrm;
pFrm = (CMainFrame#*)AfxGetMainWnd();

if (pFrm->m_pView2 != NULL) // Was second view created?
{

if (pFrm->m_currentView == 2) // Do we need to swap in
// the default view?
pFrm->SendMessage(WM_COMMAND, ID_VIEW_VIEWL1);
pFrm->m_pView2->DestroyWindow();
pFrm->m_pView2 = NULL; // Restore defaults
m_bViewCreated = FALSE;

The first thing I do is determine whether the second view was created. If
so, I switch views by switching to the default view (in this case, View 1) and clean
up the second view. After this is done, I can destroy the window and restore
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the document state by setting the pointer to the second view to NULL and
the view creation flag to FALSE. The architecture takes over and reuses the
document-view pair with no assertions or memory leaks.

Step 5: Adding Resources for Switching Views

The remaining item in this task is providing access to view switching for the
application user. I will present two possibilities but leave the implementation
details up to you.

The first alternative is a graphical interface that allows the user to
choose the current view at any time. The SWITCH program provides the fol-
lowing interface—two menu commands (View 1 and View 2) and a pair of
toolbar buttons that represent these two possible views. The current view is
indicated by a check mark next to the appropriate menu command and a de-
pressed button that represents the current view. You can get an idea of how
the interface works by looking at the resources for the SWITCH project and
the following functions:

B CMainFrame::OnUpdateViewl
This function updates the View 1 menu item.

B CMainFrame::OnUpdateViewl
This function updates the View 2 menu item.

B CMainFrame::OnViewSwitch
This function is the handler for the View 1 and View 2 menu items.

Instead of allowing the user to switch views, the second alternative de-
termines when the views need to be switched according to the occurrence or
nonoccurrence of a specific event. For instance, let’s say a user is changing
rectangle values using the form view. When the Update Rectangle button is
clicked, the application updates the document’s data automatically and
switches to the graphical view. If the user chooses a hypothetical Modify Val-
ues menu command to modify the current values, the view is switched to the
form. When the user clicks the Update Rectangle button, the view switching
function in the BN_CLICKED command handler of the form view is called.
When the user chooses the Modify Values menu command, the view switch-
ing function in the Modify Values command handler is called.

After implementing the user interface of your choice, rebuild your
project. You now have two views that can be switched and that display the data
of a document.
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Additional Information
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In addition to the AddView/RemoveView method that has been described
here, there is also a method that switches the views by manipulating the win-
dow IDs of the alternate views. This second method is discussed in detail in the
Knowledge Base article “SAMPLE: VSWAP32 Demos Multiple-View Switching
in SDI”: Q141334.



CHAPTER F OUR

Dialog Boxes

The focus of this chapter is on MFC dialog boxes. I have organized the four
tasks in the chapter according to the amount of modification to the dialog box
that is required. The first two tasks are examples of general modifications of
the dialog box; the last two are examples of specific modifications to the vari-
ous dialog box attributes. These are the tasks included in this discussion:

B Implementing a custom DDX function Demonstrates how to imple-
ment a custom dialog data exchange (DDX) function that displays
float and double type values in an edit control without using scientific
notation.

Customizing common dialog boxes Demonstrates how to customize

both modal and modeless MFC common dialog boxes. The task modi-
fies the File Open dialog box (both Microsoft Windows 3.x style and

Windows Explorer style) and the Find Text dialog box.

Using bitmaps as the background in a dialog box Demonstrates how
to modify the background of a dialog box using bitmaps (or a pat-
terned brush) to customize the appearance. In addition, I handle the
WM_CTLCOLOR message to blend the dialog box controls into the
dialog box background.

Modifying the attributes of dialog box controls Demonstrates how
to modify the attributes of various common dialog box controls such
as the text color used by a radio button group, the font used by a static
control, and the visibility of a control.

Implementing a Custom DDX Function

The purpose of this task is to discuss and demonstrate the requirements for
implementing a custom DDX function. Standard DDX functions implemented
by the MFC library provide a safe way to exchange data between a control in a
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dialog box and a data member of the class that represents the dialog box. But
despite the wide range of data types supported by these functions, you might
still need to design your own customized DDX functions. Common reasons for
extending the standard DDX functions include the need to exchange differ-
ent data types, to add new exchange and validation procedures, and to provide
custom handling for standard data types (demonstrated by this task). When
implementing custom DDX functions, the hardest part is developing the code
(usually divided into helper functions) that does the calculating and formatting
of the data, if that is required.
The task has two steps:

# Declaring the custom DDX function

B Implementing the custom DDX function

In addition, I describe a custom DDX function that displays float values
and double values without exponential notation in an edit control. The float
version of the DDX_Text function found in the MFC library occasionally dis-
plays scientific notation.

The name of the project is CUSTDDX, and the requirement is a dialog
box class with an edit control.

NOTE: This task uses multiple functions to demonstrate clear-
ly the inner workings of DDX_ MyFloatText and DDX_ MyDoubleText.
However, there is no rule that says your custom DDX function must
have helper functions.

Step 1: Declaring the Custom DDX Function
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The standard form of a custom DDX declaration is as follows:
DDX_function_name(pDX, nIDC, value);

There are three parameters to this function:

# pDX A pointer to a CDataExchange object. The framework supplies
this object to establish the context of the data exchange, including its
direction.

& nIDC The ID of the control in the dialog box, form view, or control
view object that is exchanging data.

B value A reference to a data member in the dialog box, form view, or
control view object.
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Declare your custom DDX function, following the standard format; this
makes the customized DDX function easier to identify and use. In the inter-
est of modularity, it’s a good idea to contain the declaration and implemen-
tation code in two files—a header file and an implementation file. The
sample project demonstrates this modularity by declaring the custom func-
tions in MYDDX.H and their implementation in MYDDX.CPP. In the follow-
ing code sample, the custom DDX functions used in CUSTDDX are declared:

// Custom DDX functions

void AFXAPI DDX_MyFloatText(CDataExchange* pDX, int nIDC,
float& value);

void AFXAPI DDX_MyDoubleText(CDataExchange* pDX, int nIDC,
double& value);

Now that you have declared the custom DDX functions, move on to the
real work—the actual implementation of the custom DDX functions.

Step 2: Implementing the Custom DDX Function

Another reason to keep the declaration and implementation of the custom DDX
function (and any helpers) in two files is to “hide” those functions that are
used internally. For example, the CUSTDDX project declares three additional
functions that are used internally by the custom DDX functions; these func-
tions are declared as follows:

static BOOL AFXAPI SimpleFloatParse(LPCTSTR 1pszText, double& d);
static void AFXAPI MyTextFloatFormat(CDataExchange* pDX,
int nIDC, void* pData, double value, int nSizeGecvt, int
nSizeType);
static void StripZeros(LPTSTR szNumber);

The use of these functions is explained (on page 114).

The function body of a custom DDX function is broken into two parts:
code that moves data from the dialog box class to the actual dialog box con-
trol, and code that moves data from the actual dialog box control to the dia-
log box class. Your custom function can determine the direction of transfer
by checking the value of a data member (in this case, m_bSaveAndValidate) of
the CDataExchange class. The following example shows the framework of a
typical DDX function:

static void AFXAPI MyDDXFunction(CDataExchange* pDX,
int nIDC, void* pData, double value, int nSizeGcvt, int
nSizeType)

(continued)
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// Initialization code
if (pDX->m_bSaveAndValidate)

{

// Transfer data from the control to the class
}
else
{

// Transfer data from the class to the control
}

At this point, I leave the actual implementation of your custom DDX
function to you and continue with a discussion of the DDX_MyFloatText cus-
tom DDX function in the CUSTDDX project.

Discussion of the DDX_MyFloatText Custom DDX Function
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As I mentioned before, the custom DDX functions of the CUSTDDX project
are modularized. The entire body of the custom DDX functions consists of a
call to MyTextFloatFormat, which is where the real work is done. The following
is the declaration of MyTextFloatFormat:

static void AFXAPI MyTextFloatFormat(CDataExchangex* pDX,
int nIDC, void* pData, double value, int nSizeGcvt, int
nSizeType);

The code sections from the MyTextFloatFormat function are discussed
here in the order in which they appear in the function. In the code section
below, some initialization and checking is done. First I check to see whether
there is any data to be transferred (the assertion on pData); then I allocate a
buffer to store the data string from the edit control of the dialog box.

ASSERT(pData != NULL);
HWND hWndCtrl = pDX->PrepareEditCtr1(nIDC);

// Make sure your buffer is big enough. Strings returned by
// _stprintf() using the "f" specifier tend to be longer

// than those returned using the "g" specifier.

TCHAR szBuffer[64];

The next code sample handles the transfer of data from the dialog box
control to the class. It is executed only if m_bSaveAndValidateis TRUE, indicat-
ing that the transfer is from the control to the class. First the text is retrieved
with a call to ::GetWindowText. Then I call an internal helper function, Simple-
FloatParse, to parse the text string. If the parsing fails (a valid float is not found),
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a message box is displayed and an exception is thrown. (For more details on
the SimpleFloatParse function, see the MYDDX.CPP file in the CUSTDDX proj-
ect.) If the parsing succeeds (a valid float is found), the value is cast to the
proper data type (based on nSizeType) of the dialog box class. The transfer is
then complete.

::GetWindowText(hWndCtrl, szBuffer, _countof(szBuffer));
double d;
if (!SimpleFloatParse(szBuffer, d))
{
AfxMessageBox (AFX_IDP_PARSE_REAL);
pDX->Fail(); // Throws exception
}
if (nSizeType == FLT_DIG)
*((float+)pData) = (float)d;
else
*((doublex)pData) = d;

The following code sample handles the other half of the transfer: the
transfer of data from the dialog box class to the dialog box control. First the
szBufferis loaded with the current data value according to the format control
string. The string is then cleaned up by calling another internal helper func-
tion, StripZeros. (For the implementation of this function, see the MYDDX.CPP
file in the CUSTDDX project.) This function removes any trailing zeros from

* the value. (A single zero is left after the decimal if the number has no frac-
tional value.) The value is then transferred to the edit control of the dialog
box with a call to SetWindowText. The transfer is then complete.

_stprintf(szBuffer, _T("%.*f"), nSizeGcvt, value);
StripZeros(szBuffer);
SetWindowText (hWndCtrl1, szBuffer);

Additional Information

Some of the more common DDX functions in MFC are DDX_Text, DDX_ Radjo,
and DDX_Control. For a complete listing of DDX functions, search for the
string “DDX_" in the Microsoft Visual C++ version 5 online documentation. For
more information on the mechanics of DDX, see Technical Note 26 in the
Visual C++ online documentation.

There is another aspect of exchanging data between a dialog box con-
trol and a data member—dialog box data validation (DDV). DDV is respon-
sible for validating the data entered into dialog box controls. Depending on
the data type, the developer provides a proper range for the value or for a cer-
tain type of format. For instance, numbers of type float can have only one
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decimal point. (For more information on DDV, see Technical Note 26 in the
Visual C++ online documentation.)

Customizing Common Dialog Boxes

The purpose of this task is to customize Microsoft Windows common dialog
boxes using MFC classes. Windows common dialog boxes can be divided into
two types:

B Modal dialog boxes Dialog boxes that require the user to respond
before continuing the program. They include the File Open, File
Save As, Print, Color, and Font common dialog boxes.

B Modeless dialog boxes Dialog boxes that do not require the user to
respond before the program continues. The Find and Replace Text
common dialog boxes are the only modeless types of dialog boxes
available.

Common dialog boxes, whether they are modal or modeless, can be cus-
tomized in two ways. The first type of customization changes the functionality
of the dialog box without changing the appearance. The second type of
modification adds or removes controls from the dialog box.

The latter type of modification alters the dialog box template and dis-
plays the modified version. For example, when you open a file using the File
Open common dialog box, you can request more information from the user
regarding the properties of the file. Modifications of this type can be made by
deriving the class of the dialog box that is used in the File Open procedure
from an MFC common dialog box class and adding code that requests addi-
tional information from the user. In this task, I demonstrate how to make the
second type of modification to both modal and modeless dialog boxes by
adding controls to the File Open and Find Text dialog boxes and by remov-
ing existing controls from them. This task also demonstrates how to customize
both the Windows Explorer style and the earlier Windows 3.x style of the File
Open dialog box. One example demonstrated by this task uses the class
CFileDialog to customize the File Open dialog box. The name of the project is
CMNDLGS, and the requirement is two dialog box classes derived from MFC
common dialog classes, such as CFileDialog and CFindReplaceDialog.

Customizing Modal Common Dialog Boxes

Modal dialog boxes interrupt the flow of execution in a program because the
user must dismiss the dialog box by clicking OK or Cancel before the program
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can continue. For this reason, the life cycle of the dialog box is contained
within the scope of the function that invokes it. An example that is familiar to
anyone who has developed an MFC application is the MFC application About
dialog box created by AppWizard.

MFC supports many types of modal common dialog boxes. This task
adds either a Windows 3.x style or a Windows Explorer style File Open dialog
box. The basic procedure for implementing a customized modal common
dialog box includes these steps:

Copying the common dialog box template
Customizing the common dialog box template

Initializing and invoking the customized dialog box

Handling requests from the customized dialog box

SANE T o e

Providing Help for the customized dialog box

NOTE: In the interest of brevity and focus, the results of the
procedures in this task differ from what is implemented in the
project. If you follow the procedures in this task, your project will
implement either the Windows 3.x style or Windows Explorer style
of the File Open dialog box and a Find Text dialog box. However,
the project'example implements both styles of File Open dialog
boxes. The Windows 3.x style File Open dialog box is highly modi-
fied to allow the user to select a directory instead of a file. The Win-
dows Explorer style File Open dialog box is only slightly modified
by adding a bitmap and a text string.

Step 1: Copying the Common Dialog Box Template
Each common dialog box is based on a dialog box template. Unless you are
planning extensive modifications to the dialog box’s appearance, customizing
the original common dialog box template saves time and provides some simi-
larity between the original version of the dialog box and your modified version.
Copy the dialog box template to your project. All common dialog box
templates are stored in the Visual C++ INCLUDE directory. The Windows 3.x
style File Open dialog box template named FILEOPENORD can be found in
the FILEOPEN.DLG file. To insert a copy of the FILEOPENORD dialog box
template into your project, follow this procedure:

1. Open your project’s resource file (in the case of the sample project,
CMNDLGS.RC) as a text file in Microsoft Developer Studio.
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2. Open FILEOPEN.DLG as a text file in Developer Studio.
3. In FILEOPEN.DLG, go to the following line of text (line 7):

FILEOPENORD DIALOG DISCARDABLE 109, 35, 165, 134
Copy lines 7 through 84. The last line you copy should be this one:
END

5. Insert the copied text into the Dialogs section of your project’s RC file.

6. Because the FILEOPENORD template contains several resource IDs,

you must include the DLGS.H file in your project’s RC file. The fol-
lowing lines of code, which are located near the top of the resource
file, demonstrate the finished result:

f#include "afxres.h"
fFinclude "dlgs.h”

After pasting the File Open dialog box template into your project’s
RC file, save the changes. You should now see a new dialog box re-
source named FILEOPENORD.

Customizing a Windows Explorer style modal dialog box requires a pro-
cedure slightly different from the one used for customizing a Windows 3.x
style dialog box. The Windows Explorer style dialog box does not use a stan-
dard dialog box template. Instead, you must create a new dialog box resource
and allocate an area in the dialog box that will contain the controls of the dia-
log box. Follow the procedure below to create a new dialog resource for the
Windows Explorer style dialog box.

1.

2.
3.

To your project’s resource file, add a new dialog box resource with
the following styles: DS_3DLOOK, WS_CHILD, WS_CLIPSIBLINGS,
DS_CONTROL, and a Border Style of none. The sample project uses
the name IDD_W95_FILEOPEN for the dialog box resource.

Remove the OK and Cancel buttons from the new dialog box resource.

Add a static control of reasonable size, with an ID of stc32and no cap-
tion, to the dialog box template. (A rectangle of 115 by 200 pixels is
sufficient.) The area of this static control should be fairly large so
that the controls of the Microsoft Windows 95 File Open dialog box
can be placed inside. This static control is needed only if you must
have the common dialog controls placed in a certain area.
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4. After you have finished customizing the dialog box resource, save the
resource file.

Step 2: Customizing the Common Dialog Box Template

Now that you have a copy of the File Open dialog box in your project, you can
customize it to suit your needs. Common customizations include adding, hid-
ing, or rearranging the dialog box controls and changing other attributes of
the dialog box. At this point, make any necessary modifications to the new
dialog box resource.

NOTE: If you are adding a Windows Explorer style File Open
dialog box, you can hide existing controls in the dialog box template
by sending the CDM_HIDECONTROL message to the Send Message
function of the control or controls to be hidden in the OnInitDialog
of your customized dialog box class. CDM_HIDECONTROL is dis-
cussed in the Microsoft Win32 SDK online documentation.

The Windows 3.x style File Open dialog box used in the project example
was customized (Figure 4-1) to allow the user to select a directory instead of
a file. The modifications included removing the File Name edit and list box-
es, the Read-Only check box, and the List Files Of Type list box.

Figure 4-1.
The modified Windows 3.x style File Open common dialog box.
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The Windows Explorer style File Open dialog box that is used in the proj-
ect example was customized slightly by adding a bitmap and some text as shown
in Figure 4-2.

i Cmindigs. exe 2 Crndigs. pdb B StdAfxobi
ED Cmndigs.res B vedidb

© cmndigsDoc.obi & Ved0.pdb
B crandigsView. obj
ED MainFrm.obj

Figure 4-2.
The modified Windows Explorer style File Open common dialog box.

Step 3: Initializing and Invoking the Customized Dialog Box

After you have modified the dialog box template, you have to set up some
type of interface that invokes the File Open dialog box. When you are using
common dialog boxes, it is best to follow interface conventions—a File Open
menu command that invokes the File Open (Windows 3.x) dialog box and an
accelerator for the menu command. The menu command should be on the
File menu of the application. In this task the following value is used for the
menu command, which is located in the File menu:

ID Caption Prompt

ID_CMNDLG_FILE_OPEN &Open.. \+Ctrl+O Open an
existing docu-
ment\nOpen
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The following value is used for the File Open accelerator:

ID Modifier Key
ID_CMNDLG_FILEOPEN Select the Ctrl checkbox. (0]

NOTE: If you have a toolbar button that invokes the common
File Open dialog box, change the ID to match the ID you use for the
menu command. If you do not change the ID, a noncustomized File
Open dialog box will appear.

You now use ClassWizard to create the class for the dialog box and to add
a handler named OnCmndigFilefor the new menu command. OnCmndIgFileini-
tializes and displays the customized dialog box. The following code, found in
the header file of CMainFrame, declares the handler function (OnCmndlgFile)
as a member of the CMainFrame class:

// Generated message map functions
protected:

afx_msg vbid OnCmnd1gFile();

The following code, located in the implementation file of CMainFrame, de-
fines the handler function:

void CMainFrame::0nCmnd1gFile()
{

CMyFileOpenDlg cfd1g(TRUE, NULL, NULL, OFN_SHOWHELP |
OFN_HIDEREADONLY | OFN_OVERWRITEPROMPT |
OFN_ENABLETEMPLATE, NULL, this); ‘

cfdig.m_ofn.hInstance = AfxGetInstanceHandle();

cfdlg.m_ofn.T1pTemplateName = MAKEINTRESOURCE(FILEQOPENORD);
cfdlg.m_ofn.Flags &= ~0OFN_EXPLORER;

if (IDOK == cfdlg.DoModal())
{

WORD wFileOffset;

char szBuffer[128];

wFileOffset = cfdlg.m_ofn.nFileOffset;

(continued)
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cfdlg.m_ofn.1pstrFile[wFileOffset-1] = 0;

wsprintf(szBuffer, "Selected directory was %s",
(LPSTR)cfdlg.m_ofn.1pstrFile);

AfxMessageBox((LPSTR)szBuffer, MB_OK);

}

In the first section of code in the OnCmndlgFile function, I create an instance
of the CMyFileOpenDig-derived class with the necessary flags. In the second
section of code, I assign the File Open (Windows 3.x) dialog box template to
the FILEOPEN structure, FILEOPENORD, and properly initialize the instance
handle. This is done to ensure that the application that created the dialog
box receives all messages from the dialog box. I then remove the OFN-
_EXPLORER flag because I am using the Windows 3.x style for the File Open
dialog box. In the last section of code, I check the return of the call to DoModal.
If the user has clicked OK, I display a message box that shows the name of the
directory selected by the user.

One final note regarding the creation of dialog boxes: it is common
practice to override the OnlnitDialog member function of the dialog box
class. This allows you to handle any initialization issues before the dialog box
appears to the user.

In this task, I used the OnlnitDialog function to add a particular window
style, WS_EX_CONTEXTHELP, to the dialog box. This adds a question mark
to the title bar of the dialog box, which allows the user to invoke the context
help for the dialog box. I also hid all unused windows so that the tab order of
the dialog box would not be disrupted. The following code demonstrates this:

CFileDialog::0nInitDialog();
CenterWindow();
ModifyStyleEx(@Q, WS_EX_CONTEXTHELP);

GetD1gltem(stc2)->ShowWindow(SW_HIDE);
GetDl1gItem(stc3)->ShowWindow(SW_HIDE);
GetDlgItem(edtl)->ShowWindow(SW_HIDE);
GetDIgItem(1stl)->ShowWindow(SW_HIDE);
GetD1gItem(cmbl)->ShowWindow(SW_HIDE);
GetD1gItem(chx1l)->ShowWindow(SW_HIDE);

SetDlgltemText(edtl, "Junk");
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To initialize and invoke the File Open (Windows Explorer style) common
dialog box, use code similar to the code in the CMainFrame::OnCmndlgFile95
function:

void CMainFrame::0nCmnd1gFi1e95()

{
CMyFil1eOpen95D1g cfd1g(TRUE, NULL, NULL, OFN_HIDEREADONLY |
OFN_EXPLORER | OFN_OVERWRITEPROMPT |
OFN_ENABLETEMPLATE, NULL, this);
cfdlg.m_ofn.hInstance = AfxGetInstanceHandle();
cfdlg.m_ofn.1pTemplateName =
MAKEINTRESOURCE(IDD_W95_FILEOPEN);
if (IDOK == cfdlg.DoModal())
{
WORD wFileOffset;
char szBuffer[128];
wFileOffset = cfdlg.m_ofn.nFileOffset; // For convenience
wsprintf(szBuffer, "Selected file was %s",
(LPSTR)cfdlg.m_ofn.1pstrFile);
AfxMessageBox((LPSTR)szBuffer, MB_O0K);
}
}

The only difference between the code for initializing and invoking the File
Open (Windows Explorer style) dialog box and the code for initializing and
invoking the File Open (Windows 3.x style) dialog box is found in the first
section of code. The OFN_EXPLORER flag is now included because we are
creating a Windows Explorer style of File Open dialog box, and the template
name has changed to use the new dialog box template created in step 1.

Step 4: Handling Requests from the Customized Dialog Box
When the modal dialog box appears, you will have to handle all of the events
from the dialog box controls that you’ve added to the template. In addition,
you will have to retrieve information from the dialog box if the user has closed
the dialog box by clicking OK. For an example, see the control event handler
CMyFRDIg::OnFindAll in the file MYDLGS.CPP, located in the CMNDLGS
project.

To add a control event handler using ClassWizard, follow this procedure:

1. Load your project into Developer Studio, and open ClassWizard.
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2. Click the Message Maps tab, and select your dialog box class from the
list of available classes.

3. Select the object ID of the control whose event you want to handle.

4. From the list on the right, select the message for the event you want
to handle. For example, you could add a handler for the BN_CLICK
message of a common button control.

5. Click Add Function.
6. Click OK.

7. Repeat this procedure for all of the other controls that were added to
the dialog box template.

Check the return value from the call to the dialog box’s DoModal func-
tion to determine what action the user chose. For example, if the return value
is equal to IDOK, the user has clicked OK. In this case, collect any needed in-
formation from the dialog box and perform the appropriate tasks. The follow-
ing code is taken from the last part of the CMainFrame::OnCmndigFile function
and demonstrates code that executes when OK is clicked:

if (IDOK==cfdlg.DoModal())

{
WORD wFileOffset;
char szBuffer[128];
wFileOffset = cfdlg.m_ofn.nFileOffset;
cfdlg.m_ofn.lpstrFile[wFile0ffset-1]=0;
wsprintf(szBuffer, "Selected directory is %s",

(LPSTR)cfdlg.m_ofn.1pstrFile);

AfxMessageBox((LPSTR)szBuffer, MB_OK);

}

Step 5: Providing Help for the Customized Dialog Box

The last step in adding a customized common dialog box to your application
is to provide help for the dialog box. For Windows 3.x style modal dialog boxes,
you will have to add two kinds of help—help for the entire dialog box and
context help for individual controls. For modal dialog boxes in the Windows
Explorer style, you will have to add only one kind of help—context help for
individual controls.

NOTE: Under Windows 95, common dialog boxes provide only
context-sensitive help.
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Both context-sensitive help and help for the entire dialog box require
the project to have its own Help file. The default Help file support (including
a basic Help file) installed by AppWizard is sufficient for this task. For the re-
mainder of this discussion, it is assumed that you have default help support
for the application. (For information about adding context-sensitive help to
an existing project, see “Adding Context-Sensitive Help” in the Scribble tu-
torial, which can be found in the online documentation for Developer Studio.)

Adding Help for the entire dialog box Help for the entire dialog box is re-
quired only if you are adding common dialog boxes of the Windows 3.x style.
In this case, you have to add a Help button and an associated Help topic to
your dialog box. If the application’s default Help support was created by App-
Wizard, topics already exist in the Help file for each of the common dialog
boxes. In addition, this Help file opens automatically to the proper topic
when the user clicks Help in your customized common dialog box. For in-
stance, if the user chooses Help in your customized File Open dialog box, the
application Help file opens to the Open File dialog box topic. The only thing
you have to do is update the appropriate Help topic in the RTF file (the source
text used to build the Help file) of the application by adding the information
on the new controls and removing the information on the controls that you
deleted from the common dialog box template. When you are done, your
Help topic will provide full support for your customized common dialog box.

NOTE: If your application’s Help file was not created by App-
Wizard, you must manually add a Help topic for your dialog box.

Adding context-sensitive Help for dialog box controls The method for add-
ing context-sensitive Help is a four-step process:

1. Adding the context-sensitive style to the common dialog box

2. Generating help IDs for new controls in the common dialog box

3. Handling the WM_HELPINFO message

4. Displaying the appropriate topic in your application’s Help file

Adding the context-sensitive style can be performed in two ways. The
first opportunity occurs when you add the dialog box resource to your
project’s RC file. After you have added the dialog box resource, you can open

the properties for the dialog box resource and select the Context Help style
check box found on the Extended Styles tab. The second opportunity occurs
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when you initialize the dialog box itself. In the OnlnitDialog function of your

dialog box class, place the following code after the call to the base class:
ModifyStyleEx(@, WS_EX_CONTEXTHELP);

Help IDs for controls are used to map the Help request to an existing
Help topic in the application’s Help file. You can create a Help ID for a con-
trol by bringing up the properties for the control in your dialog box and se-
lecting the Help ID check box on the General page. Save the file; a new Help
ID for the control is generated automatically by the Resource editor and add-
ed to the project’s RESOURCES.HM file. This file contains the Help IDs gen-
erated by the Resource editor. After you have added Help IDs for all new
controls in the dialog box, save the RC file.

You must include the RESOURCES.HM file in the HP]J file of the appli-
cation so that the Help IDs can be used by the Help file. Assuming that RE-
SOURCES.HM is located in the application’s root directory, add the following
line in the [MAP] section of the application’s HP] file:

f#include <..\resource.hm>

This line adds the IDs generated by the Resource editor to the existing IDs of
the Help file, which are then used by the Help compiler when building the
application’s Help file. For the mapping to work, there has to be a related
Help topic for each control. Therefore, add a topic for each new control, using
its associated Help ID for the context string, to the source file AFXCORE.RTF.
If the application was created with AppWizard, the file should be located in
the HLP subdirectory of your project.

Now use ClassWizard to add the WM_HELPINFO message handler to
your common dialog box class. Add code to the WM_HELPINFO message
handler that opens the correct topic in your application’s Help file. Gener-
ally, your code should check each Help ID for a match with the Help IDs of
your new controls. If a match is found, call WinHelp with the Help ID. If no
match is found, pass the message to the parent class. The following code sample,
which is taken from the CMNDLGS sample program, demonstrates this:

BOOL CMyFi1e95D1g::0nHelpInfo(HELPINFO* pHelpInfo)
{
UINT helpContext = pHelpInfo->dwContextId;

if ((helpContext == 0x808203e9))
{
WinHelp(helpContext);
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return TRUE;
}
else
return CFileDialog::0nHelpInfo(pHelpInfo);
}

The first line sets helpContext equal to the Help ID of the topic being requested.
This makes the function more readable. Next, I use an if statement to check
the Help ID against the Help ID of a new control. If the IDs match, I make a
call to WinHelp, passing along the proper ID. If the Help ID does not match
the new control, it is passed along to the parent class for proper handling.

Customizing Modeless Common Dialog Boxes

As I mentioned earlier, the primary difference between modal and modeless
dialog boxes is that modeless dialog boxes, although they are visible, allow
the program to continue execution. Because of this flexibility, the modeless
dialog box object is constructed using the new operator, which allocates
memory from the application’s heap for the object. Therefore, the scope of
the object is extended beyond the function in which it was created. Extend-
ing the scope is necessary because we don’t know when the dialog box will be
dismissed by the user.

The basic procedure for implementing a customized common dialog box
of the modeless type is similar to the procedure used for a modal dialog box
except for some variation in step 3 (initializing and invoking the customized
dialog box) and step 4 (handling requests from the customized dialog box).
Because of this similarity, steps 1, 2, and 5 below will mostly just reference the
corresponding step in the customization procedure for the modal dialog box.
The Find Text common dialog box will be used as an example of customizing
a modeless common dialog box.

Step 1: Copying the Common Dialog Box Template

The only difference in this step between customizing a modeless dialog box
and customizing a modal dialog box is what dialog box template you use. The
Find Text template we are using for a modeless dialog box can be found in
the FINDTEXT.DLG file. To insert a copy of this resource into your project,
follow this procedure: ‘

1. Open your project’s re